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Acronyms 
 
ACH  Automated Clearing House 
ADMIN Administration 
AFSRB APHIS Financial Systems & Reporting Branch 
AP   Account Payable 
APHIS  Animal and Plant Health Inspection Service 
AR  Accounts Receivable 
AVC  Availability Control 
BESB  Budget Execution Support Branch (part of FMD, Riverdale) 
BI  Business Intelligence 
BOC  Budget Object Code 
BOBJ  Business Objects 
BP  Budget Period 
CM  Cost Management 
CR  Change Request 
DOC  Document 
DPR  Down Payment Request 
DP  Down Payment 
ECC  ERP Central Component 
FM   Funds Management  
FMD  Financial Management Division 
FMMI  Financial Management Modernization Initiative  
FN  Foreign National  
FOB  Financial Operations Branch (part of FMD, Minneapolis) 
FOST  Financial Operations Services Team (used to be part of APT before it split) 
GL  General Ledger 
GSA  General Services Agency 
HANA  High Performance Analytical Appliance 
IAS  Integrated Acquisition System 
INTR  Intra-USDA Reimbursable 
IOAT  International Operations & Accounting Team (used to be part of APT before it split) 
IPAC  Intra-Governmental Payment and Collection System 
LIACR Line Items – Actual Costs/Revenues 
MPLS  Minneapolis 
MRP  Marketing and Regulatory Programs 
MRPBS Marketing and Regulatory Programs Business Services 
NFC  National Finance Center (part of USDA, New Orleans)  
OCFO  Office of the Chief Financial Officer (part of USDA, New Orleans)  
OH  Overhead 
OMB  Office of Management & Budget 
OTC  Over the Counter 
PROP  Property System 
RONA  Reimbursable Order No Advance 
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ROR  Reimbursable Order Report 
ROWA Reimbursable Order With Advance 
ROWE  Reimbursable Order With Exception 
RRB  Resource Related Billing  
SF  Standard Form 
SHC  Short Hand Code 
SO  Sales Order 
SOF PTD Status of Funds, Project to Date 
SPS  Secure Payment System 
SWIFT  Society for Worldwide Interbank Financial Telecommunication 
TAS  Treasury Account Symbol 
TAFS  Treasury Appropriation Fund Symbol 
TF  Trust Fund 
TOWA  Trust Order With Advance 
ULO  Un-Liquidated Obligation  
USDA  United States Department of Agriculture 
VS  Veterinary Services 
WBS  Work Breakdown Structure 
WS  Wildlife Services 
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APHIS Financial Information Flow 
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Accounts Payable 
 
Feeders or Interfaces 
WebTA/Payroll (Employee Payments) 
GovTrip (Govt Travel) 
SmartPay 2 (Purchase Cards) 
WEX (Fleet Cards) 
PROP (Property) 
IAS (Procurement) 
Ameresco (Utilities) 
Metel (Telephone) 
  
Manual Entries  
IPAC*  
VADRs* 
ePRES (foreign payments) 
SPS (same day payments) 
Employee Reimbursements (SF-1164s) 
eFABS (Allowances) 
Misc Pay 
BSE 
Coop Agreements 
EEO Payments 
Training (SF-182) 
Fee Basis 
Grants 
Honorariums 
Indemnities 
Patent Royalties 
Postage 
Tort Claims 
Transportation 
UPS 
Contracts 
Adjustments 

Accounts Receivable 
 
Feeders or Interfaces 
Lockboxes 
VS User Fee System 
  
Manual Entries 
ACH 
FedWire 
IPAC  
Pay.gov 
Lockbox Rejects 
Sales Orders 
Billings (non-SO related) 
Modifications 
Transfers 
Refunds 
Write Offs 
 
SO Jobs FOB Runs 
Overhead 
RRB Billing 
 

 

 

 

 

*Feeders being developed 
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Master Data Overview 
 

FMMI Master Data Elements 
Budget Period         4 characters 
Application of Funds       6-8 characters 
Fund          10 characters  
Fund/Cost Center        10 characters  
WBS Element/Funded Program       APHIS up to 18 characters  
Functional Area        16 characters 
Short Hand Code        27 characters 
Commitment Item (BOC) or Revenue Source Code (RSC)  4 characters 
 
Budget Period (BP) 
The BP indicates both the beginning and ending budget fiscal years for a fund. Each budget fiscal year begins 
October 1st and ends September 30th. Budget periods can be annual, multi-year or no-year. 
 
Example 
 Annual  1515 
 No-Year 15XX 
 Multi-year 1415 

 
Application of Funds 
The Application of Funds used in FMMI is the equivalent of the String Treasury Accounting Symbol (TAS).  Each 
Application of Funds is tied to one or more FMMI Funds. 
 
Examples of Application of Funds: 
 12_1600 - Salaries and Expenses, APHIS 
 12X1600 - Salaries and Expenses, APHIS 
 12X1601 - Buildings and Facilities, APHIS 
 12X5161 - Agricultural Quarantine Inspection User Fee Account, APHIS 
 12X8226 – Miscellaneous Contributed Funds (Trust Funds), APHIS 

 
Link to Treasury Account Symbols: http://www.fiscal.treasury.gov/fsreports/ref/fastBook/fastbook_home.htm 
 
Funds 
Funds in FMMI are used to represent the type of funding and its funding source.  Using the Fund and Budget 
Period together indicates the availability of funding as it pertains to time (no year, annual funds, multi-year funds).  
It includes the specific attributes indicating the type of funding; e.g., direct, trust, special, or reimbursable.  A 
complete list of APHIS Funds is maintained in the BAM, Chapter 5, Exhibit 2. 
 
OMB Recognized Category Programs 
 Cat A – Defined by Time – Quarterly Apportionments 
 Cat B – Project Specific – Apportionments other than quarterly 

 
Examples of Funds: 
 AP001600AD – General Direct-Cat A 

http://www.fiscal.treasury.gov/fsreports/ref/fastBook/fastbook_home.htm
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 AP001600AR – General Reimbursable-Cat A 
 AP0016IEAR – Import/Export User Fees; General-Reimb-Cat A 
 AP005161AV – Special AQI-Cat A  
 AP00160MBN – Farm Bill; Non-Approp-Transfer-Cat B  
 AP008226AV – Trust Fund; Distrib-Recipt-Trust Avail-Cat A 
 

Fund/Cost Centers 
Fund/Cost Centers are organizational elements that identify where the costs are incurred for performing activities 
within APHIS, generally representing staff and location.  A Fund/Cost center should not be used for tracking a 
project or functional area.  That can be accomplished with the combination of master data at time of obligation. 
 Fund Centers and Cost Centers have a one to one relationship. Cost Centers reside in the Controlling 

Module (i.e., Cost Management) while Fund Centers reside in the Funds Management Module. 
 Fund/Cost Centers reflect the level at which a Division spends at a location. 

 
Examples of Fund/Cost Centers 
 APWSHQ0024 – WS Headquarters, Maryland 
 APWSER0037 – WS Eastern Region Office – North Carolina 
 APWSRC0008 – HQ National Wildlife Research Center 
 APWSWR0008 – WS Western Region Office - Colorado 

 
Functional Areas 
APHIS functional areas should reflect the specific line items from our Appropriation Language received each year, 
or indicate the type of funding that is being received, such as AQI User Fees, and Non-AQI User Fees.  A complete 
list of Functional Areas is maintained in the BAM, Chapter 5, Exhibit 4. 
 
Examples of Functional Areas 
 AP00AGDISTRIB000 – APHIS Distributable- Cat A (00) 
 AP00AGREIMBUR000 – Reimbursable Agreements – Cat A (00) 
 AP02SUFB10201000 – Farm Bill-Plant Pest/Dis Mgmt – Cat B (01, 02 or 03) 
 AP01GPCITGREN000 – Citrus Greening - Cat B (01, 02 or 03) 

 
Funded Program/Work Breakdown Structure (WBS) 
 Provides a means of collection and tracking costs of a specific job, service, project, or task.  
 WBS Elements should be thought of as a program or project with an operational purpose and a defined 

timeframe. These should be created when it is not possible to track costs using Functional Area, Cost 
Center, and Budget Object Code.  

 WBS Elements (Cost Management Module) have a one-to-one relationship with Funded Programs (Funds 
Management Module).  This helps to provide consistency between the Cost Management and Funds 
Management modules in FMMI.  

   
APHIS uses up to 3 WBS level: 
 Level 1 – AP.xx.xxxx   
 Level 2 – AP.xx.xxxx.xx  Spending occurs at level 2 or higher 
 Level 3 – AP.xx.xxxx.xx.xxxx 

 
WBS Expense Project (AP.EX.xxxx.xx) 
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 WBS elements for expense projects can be mapped to multiple cost centers. 
 
WBS Reimbursable/Trust Fund Project (AP.RA.xxxx.xx and AP.TF.xxxx.xx) 
 WBS elements for reimbursable/trust projects can only be mapped to one cost center. 

 
Shorthand Code (SHC) 
The Shorthand Code (SHC) is a way to shorten the length of accounting information that gets sent into FMMI by 
feeder systems.   
 
Shorthand Code Format: 
 Budget Period (2) + Cost Center (8) + Functional Area (7) + WBS Level 2 (6) + WBS Level 3 (4) 

 
 Example: 
 44WSHQ0808EPPSODEPD00011234 

  Budget Period: 1414 
  Cost Center:  APWSHQ0808 
  Functional Area: AP00PDEPPSODE000 
  WBS Level 2: AP.EX.PD00.01  (If no WBS fill with “PUBLICUSDA”) 
  WBS Level 3: AP.EX.PD00.01.1234  (If only a WBS Level 2, fill with “USDA”) 

 
Commitment Items  
Commitment items, also known as budget object classification codes (BOC) and/or revenue source codes (RSC) are 
used by the Federal Government to record its financial transactions according to the nature of the services provided 
or received. 
 
Examples of BOCs 
 1100 – Personnel Compensation 
 2570 – Miscellaneous Services 
 4200 – Insurance Claims and Indemnities 

 
Examples of RSCs 
 0100 – Operating Income 
 0200 – Revenue from services provided – exchanged (i.e., sales orders) 
 0202 – Revenue – Anticipated (i.e., AQI User Fees) 
 0203 – Commercial Activity – Exception (i.e., VS/PPQ User Fees) 

 
Link to APHIS FMMI Master Data:  FMD Quick Reference Guide  
Link to the BOC Manual:  https://cod.nfc.usda.gov/Documents/toc.html  (PDF Searchable) 
 

General Ledger Overview 
 
The United States Standard General Ledger (USSGL) provides a uniform Chart of Accounts and technical guidance 
to be used in standardizing federal agency accounting.  FMMI incorporates the United States Standard General 
Ledger (USSGL) and uses the USSGL's Chart of Accounts.   
 
GL account numbers are assigned within the predefined ranges detailed below. 

http://www.aphis.usda.gov/wps/portal/aphis/ourfocus/business-services?1dmy&urile=wcm%3apath%3a%2Faphis_content_library%2Fsa_our_focus%2Fsa_business_services%2Fsa_applications_systems%2Fsa_fimmi%2Fct_quick_reference_guide
https://cod.nfc.usda.gov/Documents/toc.html
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USDA APHIS’ GL structure is as follows:  the four-digit USSGL number, subsidiary GLs (sub-GLs), and the four-
digit RSC/BOC.  These GL accounts roll up to the four-digit USSGL accounts.  
 

 

The G/L Chart of Accounts can be found in FMMI by running an ECC report located under:   
General Ledger Management > Financial Reports > General Ledger Reports > G/L Chart of Accounts Report 
 

 
 

USSGL Link:  http://fms.treas.gov/ussgl/index.html   (PDF Searchable) 
 

 

 

http://fms.treas.gov/ussgl/index.html
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Sales Orders Intro 

Overview 
 

Sales Order (SO) - A document that is generated by the seller to authorize the sale of products or 
services on receipt of the customer’s order.   
 
Purpose:   

• Businesses use SOs as a way to forecast or track sales   
• Can be used to track specifics of the agreement (dates, description, etc) 
• Used in the APHIS Overhead (OH) and Resource Related Billing (RRB) processes 
• Used with Customers 

 
Not Used for: 

• Capturing costs  (WBS Elements do that) 
• Capturing collections  (Customers and Bills do that) 
• Purchasing (Purchase Orders do that, and are used with Vendors) 
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Sales Order Types – APHIS 
Order 
Type 

Name SO 
Number 
Begins 
With 

FMMI Fund Description 

RONA Reimbursable 
Order No 
Advance (Spend 
then bill) 

32 AP001600AR Sold-to Party – Cooperator - Federal Agencies –  
Non-USDA 
 
Budget Authority – Established when Sales Order is 
entered. 
 
Bill or Stmt - Bills are processed through IPAC (by 
NFC). 

INTR Inter-USDA 
Agency 
Agreement 
(No Advances) 

36 AP001600AR Sold-to Party – Cooperator – Federal USDA Agencies 
 
Budget Authority – Established when Sales Order is 
entered. 
 
Bill or Stmt – Bills are processed through IPAC. 
 
Order Specific Field (Header Data) – Must include a 
P.O. reference number from USDA agencies currently 
in FMMI.  FMMI will validate against this P.O.   

ROWA Reimbursable 
Order with 
Advance 

33 
 

AP001600AR Sold-to Party – Cooperator – Commercial Customer, 
Universities, and State and Local governmental entities. 
 
Budget Authority – Established when the check has 
cleared in FMMI.  The authority is the amount of the 
check. 
 
Material – REIMB 
 
Bill or Stmt – RRB Bill run solely to move collection 
from liability to revenue GL.  No bill or stmt to 
customer.   

ROWE Reimbursable 
Order With 
Exception 
(No Advances) 

61 AP001600AR 
 

Sold-to Party – Cooperator – Commercial Customers, 
Universities, and State and Local governmental entities.   
 
Budget Authority – Established when Sales Order is 
entered. 
  
Bill or Stmt – RRB Bill Mailed Monthly or Quarterly 
(except WS OTC Accts – RRB Bills Not Mailed) 

TOWA Trust Fund Order 
with Advance 

37 
 

AP008226AV 
 

Sold-to Party – Cooperator – Commercial customers. 
 
Budget Authority - Established when the check has 
cleared in FMMI.  The authority is the amount of the 
check. 
 
Bill or Stmt - Customer Statement emailed monthly. 
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OTC ROWE SO Differences 
 

Purpose 
Over the Counter (OTC) Sales Orders were established to account for all WS reimbursable sales without creating 
an individual Customer Account and Sales Order.  These may include, but are not limited to, customers paying at 
the time of service, small dollar amounts, and/or one-time transactions.   
 
SO Type 
ROWE 
 
Differences from other ROWE SOs 

DIFF 1: A customer number was established for each state office.    
o The name associated with the customer should read Wildlife Services, the name of the state, and 

OTC.     
 

 
  

 
DIFF 2: These customer numbers were set up to be account statement customers  

(i.e. 2 filled in Account Statement box – see arrow below).  
o OTC (account statement customers) collections post to the customer number.  This was done 

since many times collections are received prior to the bill being issued.  This keeps these 
collections tied to a customer even though they are initially posted in a suspense fund (i.e. 
AP0006501A).   

o “Regular” ROWEs collections post directly to the bill number. 
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DIFF 3: The billing address was set up with the Minneapolis FMD PO Box (see arrow below).   
 

 
 
DIFF 4: Bills are generated by Resource Related Billing (RRB) monthly but are not mailed to the state offices.   
  RRB captures all eligible (billable) expenses posted to the SOs WBS and BP.   

 
DIFF 5:  FIFO - Each night, a nightly cycle will run that will apply any collections posted to a customer number 
and suspense fund (AP0006501A) to the oldest open bills created by resource related billing.     

 
If there are more unapplied funds on the customer number than there are expenses on the bill created by 
RRB, the remaining funds will sit on the customer number and suspense fund until the next round of RRB 
captures billable expenses.    If this happens there could be one collection that is partially applied to two 
different billing documents.    

 
If the bill created by RRB is larger than the amount of funds sitting on the customer number, the nightly 
cycle will apply all of the collection(s) to the bill.   When another collection arrives and is posted to the 
customer number, the next nightly cycle will apply that check to the bill.   This will continue until the bill is 
paid in full. 
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APHIS ROWE SO Flowchart 
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APHIS ROWA SO Flowchart 
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APHIS INTR vs RONA SALES ORDERS Flowchart 
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APHIS SO CREDIT MEMO PROCESS Flowchart 
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FMMI Intro 

Accessing FMMI 
 
Instructions 

1. Go to http://info.fmmi.usda.gov/ 
 

 
 

2. Click on Login/Enroll 
 

 
 
 
 
 

 

http://info.fmmi.usda.gov/
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3. The following screen will display.  Click on Click Here to Log in with your LincPass . 
 

 
 

4. The following screen will appear.  Wait for it to process.   
 

 
 

5. The following screen will appear and choose the PIV Authentication option.  Click on OK to proceed.   
 

 
 

6. The following screen will display.  Enter your PIN and click OK.   
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7. The following screen will display.  Welcome to FMMI! 
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FMMI Report Types 
 
Determining FMMI Report Type 

• In general, you can tell what type of report it is by where it is located in FMMI.  If it is located under a BI 
tab, it is a BI report.  If it is located under a HANA tab, it is a HANA report.  If it is located under a BOBJ 
tab, it is BOBJ report.  If it is not located under a BI, HANA, or BOBJ tab, it is most likely an ECC report.   

 
FMMI Report Types 

• ECC 
o Real Time  
o Drill Down Capabilities 
o Similar to Excel 

 
Report Type Example = ECC – located under “Reports” 

 
 

• BI 
o Not Real Time, a day or so behind (date is in upper right hand corner of report) 

 
Report Type Example = BI – located under “BI Reports” 
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• HANA 
o Real Time ECC Reports  
o Created by APHIS staff or USDA Headquarters 
o AR does not have any HANA Reports created currently 

 
Report Type Example = HANA – located under “HANA Reports” 

 
 

• BOBJ 
o Not Real Time BI Reports, a day or so behind (date is in upper right hand corner of report) 
o Created by APHIS staff 
o AR does not have any BOBJ Reports created currently 

 
Report Type Example = BOBJ – located under “BOBJ Reports”
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• BI Favorites > BEx 
o Not Real Time BI Reports, a day or so behind (date is in upper right hand corner of report) 
o Created by APHIS staff 
 

Report Type Example = BEx – located under “BEx Portfolio”

 
 

 
*NOTE:  FOB (FMD Mpls) currently only reconciles to ECC and BI Reports.  These versions are the most 
standard versions to SAP (least customizations, least room for human error). 
 
*NOTE:  See Appendix A for FMMI Doc Types.  FMMI Doc Types are useful in reporting.   

 

Roles in FMMI 
 

• If you have access in FMMI to perform a function, you have the role assigned to you.  If you do not have 
access to perform the function, you have not been assigned the role.   

• You are only allowed to request/obtain roles needed for your job due to A123/Internal Controls, Separation 
of Duties controls.  Each report or function mentioned in this document identifies the role needed to 
execute the report or perform the function.  This document should identify every FMMI role you may need 
to perform your job in relation to SOs. 

• You may request needed roles through your FMMI program lead or your supervisor.  They will need to 
submit the request to APHIS-MRPBS FMD Security <aphis-mrpbsfmdsecurity@aphis.usda.gov>.   

• For questions regarding the requesting process, see the New User Access Guide. 
• The below links may help you decipher roles needed:   

o FMMI User Roles Detail 
o FMMI Roles Overview 

mailto:aphis-mrpbsfmdsecurity@aphis.usda.gov
http://www.aphis.usda.gov/mrpbs/systems/fmmi/downloads/New_User_Access_Guide.docx
http://info.fmmi.usda.gov/Policy/FMMI%20User%20Roles%20and%20Training%20v1.1.pdf
http://info.fmmi.usda.gov/Latest_News/FMMI%20D2%20Newsflash%203%20-%20Roles%20Overview_0710.pdf
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Sales Orders 

Display Sales Order (SO) 
 

Purpose 
Displaying a SO in FMMI provides a process to verify information pertaining to the sales order. Displaying a SO 
allows internal customers a way to ensure the sales order has been entered and entered correctly.  The Doc Flow 
screen of the SO allows the field to track specifics regarding bills, such as when it was billed, the amount of the bill, 
if the bill was cancelled, and whether a payment was received on the bill.     
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services SO verification needs.   
 
Report Type 
NA/ECC 
 
FMMI Role 
Accounts Receivable, AR Evaluator Role 
 
Instructions  
STEP 1:  Go to Accounts Receivable > AR Evaluation > Manage Sales Order > Display Sales Order 
 

 
 

 
 

STEP 2: Enter the desired parameters in the variable entry screen to execute the report. 
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STEP 3: If you know the SO Number you would like to view, enter the SO Number (i.e. 3200001871) in the Order  
 Field and click Search.   

 

 
 
STEP 4: If you don’t know the SO Number and want to search by WBS, enter the WBS Element  

(i.e. AP.RA.NA45.72.0031) and click Search. 
 

 
 
 
 
 

STEP 5:  The following screen will appear which lists the WBS and associated SO documents.    
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a. Note the following items: 
i. Bills (i.e. Debit Memo Requests) are eight digits long and start with the number seven (7).  

ii. Credit Memos (i.e. Credit Memo Requests) are eight digits long and start with the number 
six (6).    

iii. Sales Orders are ten digits long and start with the following numbers: 
1. ROWE  -  61 
2. RONA  -  32 
3. INTR  -  36 
4. ROWA  -  33 

b. Highlight the SO of your choice, and click the green check mark. 
 
 

 
STEP 6: Regardless of whether you open your SO using a Sales Order Number or search for it using a WBS 
Element or a Billing Document, you will see the following screen.   This is your overview screen of the Sales 
Order.    

a. Note the following items:   
i. PO Date = Date SO was created 

b. Multiple SO Line Items often represent multiple projects or tasks 
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SO Line Item Drill Down Instructions 
 

STEP 7: To see the details of a SO line, Double Click on the line you want to view. 
 

 
 
STEP 8: The following screen will appear. This shows data ONLY for the SO line item selected. 
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STEP 9: Note the following items: 

a. Contract Data Tab – shows the following: 
i. Contract Start Date =  the start date of the period of performance  

ii. Contract End Date = the end date of the period of performance    
 

 
 
 
b. Account Assignment Tab – shows the following: 

i. Overhead Costing Sheet  
1. INTR and RONA SOs, typically ZRRB1  
2. ROWE and ROWA SOs, typically ZWS13, ZWS14, ZWS15, ZWS16, ZWS17 for 

Wildlife Services, ZRRB1 all other programs 
ii. Overhead Key = Overhead Rate Charged 

3. ROWE and ROWA SOs, typically R0515, R1615, or R2715 (accounts for pooled job 
costs) 

4. If these two OH fields are blank, overhead has been waived.    
iii. Click on FM Account Assignment – shows the following:   

5. Commitment item = revenue source code.    
6. Funds Center (Cost Center) 
7. Fund  
8. Functional Area  
9. Funded Program (WBS element)  
10. Budget Period  

iv. Click the green check mark to close this screen.    
11. This brings you back to the main Account Assignment tab page.    
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c. Texts Tab - only used on RONA and INTR SOs – shows the following: 
i. Other agency’s agreement or MIPR number  

ii. Any accounting information the other agency needs for them to process the billing on their side 
iii. In some cases, such with a MIPR, the whole line of accounting provided on MIPR must be 

entered 
iv. Name and contact information for both agency’s point of contact (POC), in case of questions 
v. This tab must be filled in at the time the SO line is established. Otherwise, we can not save and 

generate the SO number.    
 

 
 
d. Order Data Tab – only used on RONA and INTR SOs – shows the following: 
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v. PO number 
12. RONA = the other agency’s agreement number or MIPR number 
13. INTR = the other USDA agency’s FMMI PO number  

vi. Purchase Order Item 
14. INTR = the line number of the purchase order  

vii.  Purchase order no. 
15. INTR = TAS (Treasury Account Symbol) in string format 

viii. This tab must be filled in at the time the Sales Order line is established. Otherwise, we can not 
save and generate the Sales Order number.    

 

 
 

e. US Federal Fields Tab – only used on RONA and INTR SOs – shows the following: 
i. As of October 1, 2014 all federal agencies must also have a componet TAS (Treasury Account 

Symbol) entered in so an IPAC billing can be transmitted via the Treasury Department to the 
other federal agency.  When submitting a request to have a Sales Order entered, please make 
sure that a TAS symbol is on the agreement.    
Note: For the military, the MIPR or MORD will have the TAS included in the line of 
accounting.  
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Tips: 

o If a SO has more than one line, you can navigate between the lines of the Sales Order even when 
you are looking at the line details by clicking on the First Item, Previous Item, Next Item, and 
Last Item buttons at the top of the screen.    

o To get back to the main header page from line detail page, click on the Back button.   
 

 
 
 

SO Display Doc Flow Instructions 
 
STEP 10:  To see the chronological details of the SO entry, billing, and refund transactions: 

a. If multiple lines on the SO, click on the line you want to analyze, and click on Display Document 
Flow.   

 
Note:  You must perform the same steps to view details on each line of the SO. 
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STEP 11: The following screen will appear.  This shows data ONLY for the SO line item selected. 

a. Note the following items: 
i. The first line shows the SO number, the amount of the SO, the date the line was created on, and 

the status. 
ii. The second line shows a Debit Memo Request (Bill Request).   A Debit Memo Request is the 

resource related billing job that pulled in the expenses.   This isn’t the ‘bill’ itself.  You can 
also see the amount of the expenses that are on the Debit Memo Request and the date the 
request was generated.  The Debit Memo request number is used to generate the Debit Memo.  
The Debit Memo Request number starts with the number seven (7).    

iii. The third line shows the Debit Memo (Bill).  This is the actual bill.   The Debit Memo 
generates accounting documents (the fourth and fifth lines).  The accounting document that 
starts with 30 is the one that will show up on your reports; and when a payment has been 
applied to this accounting document, the status will say Cleared.   The Debit memo number is 
the number that will show up on printed bills and IPAC transmittal sheets.   

iv. This example also shows a second Debit Memo Request and Debit Memo.   Each time resource 
related billing is run on a SO, you will get a Debit Memo Request, Debit Memo, and the 
accounting documents.   

v. Credit Memo Requests - Credit memo requests are reset so the negative expense will be picked 
up on the next RRB run unless we’ve received a request to “refund” the money.  This is why 
they all show as zero dollars in the example.   
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STEP 12: Drill Down into Documents by highlighting the accounting document number (i.e. 3000619756) and 
clicking on Display Document – pulls up the document – shows the following: 

a. Clearing document number applied to the bill starts with __ signifies: 
i. 30 = bill was cancelled 

ii. 24 = bill was paid with an IPAC payment 
iii. 14 = bill was paid with a check, wire, ACH or plastic card 
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STEP 13: Note the following payment details: 
a. Text Field –  

i. Check, Wire, ACH number 
ii. IPAC Document = blank 

b. Reference Field – 
i. Check , Wire, ACH = the deposit ticket number 

ii. IPAC Document = IPAC Document Reference Number (DRN) – used to trace an IPAC 
payment   

 

 
 

STEP 14: To drill down into billing document , Double Click anywhere on the top line of the billing document 
 

 
 
  The following screen will display.   
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Request New Sales Order 

SO, WBS, and SHC Request 
 
Purpose  
To coordinate the establishment of the SO, WBS and SHC, the following process has been put in place to ensure 
everything is created both properly and promptly. 
 
Instructions  
STEP 1: Complete the APHIS Sales Order Request Form  (must include TAS if Federal Agency (IPAC)) (must 
include FMMI PO number if another USDA agency) 
 
STEP 2: Complete the Accounting Code Request Form to establish new SHCs and WBSs in FMMI.   

a. SHCs – SHC Tab 
i. Only select the feeder systems where the code should be used.  Feeders include: 

1. GovTrip  Government travel transactions 
2. SmartPay2 / WEX Purchase/fleet card processing 
3. webTA   Employee time & attendance  
4. MASC   Other USDA systems (i.e., ABCO, PACS, PROP)  

5. IAS   Integrated Acquisition System (Purchasing) 
6. CPAIS   Real property system 

7. TRVL   Travel System for relocations 

b. WBS Elements – WBS Tab 
i. Programs are only allowed to request WBS Projects and Elements for reimbursable (RA) 

and trust fund (TF) purposes.   
ii. Requests to establish a new Expense (EX) WBS Project and Element must be submitted to 

PPD-BPAS for approval.  If the Functional Administrators (FAs) receive requests without 
PPD-BPAS approval they will be returned to the requester.   

 
STEP 3: Send one  email to APHIS-Master Data Requests (Master.Data.Requests@aphis.usda.gov) and MRP 

Billings Requests (MRP.Billing.Requests@APHIS.USDA.GOV) with the following: 
c. Email Subject – i.e. New SO Request - AP.RA.WLSV.GE.1234 - 

55WSWR0808WLDMGMTWLSVGE1234 
d. If you are not the designated program staff for requesting new SHCs and WBS Elements, cc: 

designated program staff   
e. Copy of Signed Agreement 
f. Completed APHIS Sales Order Request Form  (must include TAS if Federal Agency (IPAC)) 
g. Completed Accounting Code Request Form 
 

 

 
 

 

http://inside.aphis.usda.gov/mrpbs/systems/fmmi/downloads/SO_Coversheet_Fillable.pdf
http://inside.aphis.usda.gov/mrpbs/systems/fmmi/downloads/accounting_code_request_form.xls
mailto:Master.Data.Requests@aphis.usda.gov
mailto:MRP.Billing.Requests@APHIS.USDA.GOV
http://inside.aphis.usda.gov/mrpbs/systems/fmmi/downloads/SO_Coversheet_Fillable.pdf
http://inside.aphis.usda.gov/mrpbs/systems/fmmi/downloads/accounting_code_request_form.xls
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Verify New SO, WBS, and SHC 

FMMI New SO Data Entry Verification 
 
Purpose 
Displaying a SO allows internal customers a way to ensure the sales order has been entered and entered correctly.   
 
Verification Instructions:  (detailed instructions can be found in Display Sales Order) 
 
STEP 1: Header 

a. SO number begins with the correct digits  
i. ROWE  -  61 

ii. RONA  -  32 
iii. INTR  -  36 
iv. ROWA  -  33 

b. Customer name 
c. Dollar amount 

STEP 2:  Contract Data Tab 
d. Contract start date 
e. Contract end date 

STEP 3: Account Assignment Tab 
f. Overhead Costing Sheet 

i. Options and what they mean 
1. For RONA and INTR, it is ZRRB1   

a. ZRRB1 is tied to 16.15% OH for all programs 
2. For ROWE and ROWA there are multiple costing sheets.  In order to bring WS 

OH up to 5.15% as all APHIS programs are required, it was agreed to increase the 
agency OH and decrease the program OH by 1% each year and 1.15% the last 
year.  Currently this correlates to the fiscal year the change will take place (ie 
ZWS15 for FY15) but after fiscal year 2017 this will not change unless there is a 
change in either agency OH or program OH.   

a. ZWS13 = 1% agency OH and 15.15% program OH 
b. ZWS14 = 2% agency OH and 14.15% program OH 
c. ZWS15 = 3% agency OH and 13.15% program OH 
d. ZWS16 = 4% agency OH and 12.15% program OH 
e. ZWS17 = 5.15% agency OH and 11% program OH 
f. ZRRB1 = is used for all programs besides WS 

g. Overhead Key 
i. Options and what they mean 

1. Blank = OH has been waived (rare, requires Administrator or (designee) approval) 
2. R0515 = 5.15% 
3. R1615 = 16.15%  
4. R2715 = 27.15% and accounts for pooled job costs 

h. FM Account Assignment 
i. Commitment item = revenue source code.    

ii. Funds Center (Cost Center) 
iii. Fund  
iv. Functional Area  
v. Funded Program (WBS element)  

vi. Budget Period  
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New Shorthand Codes Verification  
 
Purpose 
To verify if a SHC request for activation (or deactivation) has been successfully completed in FMMI.   
 
FMMI Role 
Interface Table Maintenance Evaluator 
 
Instructions  
STEP 1: Go to Interface Table Maintenance > Shorthand Code Evaluation > Shorthand Code Table  > View 
Shorthand Code 

 

 
 
STEP 2: Enter the desired parameters in the variable entry screen to execute the reports.   
 

 
 

 
STEP 3: To search by WBS, enter the following data:   

a. Agency = 34 (APHIS) 
b. WBS Element = i.e.  AP.RA.RX47.72.0080 
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c. Click Execute to run the report 
 

 
 

STEP 4: The report will populate as shown below 
d. Note the following items: 

i. Sys ID 
ii. Status 

1. Active = Open 
2. Deactivated = Closed 

 

 
 

New WBS Elements Verification (Where Applicable) 
 
Purpose 
To verify if a WBS Elements’ request for activation has been successfully completed in FMMI.   
 
Considerations 

• WBS Elements that are reused should already be open/active.   
 
FMMI Role 
Cost Management Reporter Role 
 
Instructions  
STEP 1: Go to Cost Management > Cost Management Reports > Project Systems > WBS Master Data 
Report  
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The first time you access the report each day, you may have to enter the database prof.:  000000000001, 
click the Green Check Box 

 
STEP 2: The following screen will appear.  Enter the following: 

a. WBS Element – i.e. AP.RA.RX47.72.0080 
b. Click Execute 

 

 
 
STEP 3: The screen will populate as shown below.  Note the following items: 

c. WBS Element – if the screen populates and shows the WBS element, it is established 
d. Bill – only level 3 should be checked 
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Billing and Expenses 

Resource Related Billing Overview 
 
Resource Related Billing (RRB) is a standard SAP term used for billing Sales Orders.   
 
RRB runs off of one table in the background of FMMI (named RIA_Cell.ALL).  RRB captures all billable 
expenses.  Non billable expenses include things like depreciation expense and accruals.  The RRB table is GL 
based and maintained by OCFO for all of USDA. 
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Line Items – Actual Costs/Revenues Report (LIACR) 
 

Purpose 
The LIACR Report provides the FMMI expense documents posted to WBS Elements.  This report shows the 
Document Number, Document Type, Cost Element, Expense Amount, Doc Header Text, Line Item Description 
(Name), and the FMMI User Name, among other fields.  The report is highly customizable to limit or expand the 
data you wish to see.   
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services billing verification needs.  
• This report is the same report we use for the Overhead (OH) calculation reconciliation (eligible expenses), 

OH split reconciliation, and OH expenses posted.    
• This report does not reflect collections.   
• This report will not show expenses for your account which were posted incorrectly (ex. WBS 

FPDEFAULT).   
 
Report Type 
ECC 
 
FMMI Role 
Cost Management Reporter (ECC) 
 
Instructions 
 

STEP 1: Go to Cost Management > Cost Management Reports > Project Systems >  
Line Items – Actual Costs/Revenues 
 

 
 
The first time you access the report each day, you may have to enter the Database prof.: 000000000001, 
press Enter 
 

STEP 2: Variable entry screen will appear.  Enter the desired parameters to execute the report. 
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STEP 3: To run by WBS element, enter the following data: 
a. WBS Element = i.e. AP.RA.RX34.72.0035 
b. Select Posting Dates = i.e. 04/01/2014 to 07/31/2014 
c. Layout = 1_USDA_RRB2 
d. Click Execute to run the report 

 
Note: The report layout 1_USDA_RRB2 is customized at this time to pull only for budget periods 13XX, 14XX and 
15XX.  This report is also customized to remove all non-billable expenses.   If you need to limit or view any other 
budget period or expenses, you will have to use the filtering process explained in FMMI Reporting Tips and Tricks.    
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STEP 4: The report will populate as shown below 
 

 
 

STEP 5: Commonly Used Additional Features 
e. Drill down  
f. Filter 
g. Sort 
h. Subtotals 
i. Change Layout 

 
STEP 6: To print the report as PDF click Menu > List > Print and go to step 7 (See step 8 to export to Excel). 
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STEP 7: After Print is clicked, Click the Green Check Box and a PDF version will be available to print or save. 
 

 
 

STEP 8: To export to Excel, click Menu > List > Export > Spreadsheet  
 

 
 
STEP 9: The following box will appear, enter the path and file name of your choice and click Save. 
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STEP 10: The following box will appear, click Yes . 
 

 
 

STEP 11: An Excel version will be available to sort, print or save. 
 

 
 

*Note : to save in Excel format, Click File  > Save As  and use drop down options to change Save as Type to Excel 
Workbook. 
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Obligation/Payments Overview 
 

FMMI Master Data is not derived for most manual obligation/payment entries, and mistakes can and do happen (ex. 
multiple Fund Centers for one WBS).  It is important for people to use the most accurate data they can on every 
document.   

Types of Payments and FMMI Requirements 
Manually Entered Obligations/Payments – these are payments which are manually entered by FOST or IOAT 
into FMMI.   

Examples:  1164, Training, Coop Agreements, Misc Pays, BSE, Fee Basis, Indemnities, Transportation, 
Postage, etc. 
Required FMMI Master Data:   

• Obligation Already Entered = Obligation Number 
• No Obligation Established = Budget Period, Fund, Fund Center, Functional Area, WBS Element 

(where applicable), Commitment Item (BOC) 
 
Feeder/Interface Payments – these are payments which are loaded into FMMI through automated feeder systems.   

Examples:  Payroll (WebTA), Travel (GovTrip), Procurement (IAS), Credit Card (SmartPay2/WEX), etc. 
Required FMMI Master Data:  Short Hand Code (SHC), Commitment Item (where applicable) 
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Payments Feeder Systems Overview 
 
A financial feeder system (or also known as a secondary financial system) is a system that supports functions with 
both financial and non-financial aspects, such as logistics, acquisition, and personnel, and typically feeds financial 
data into the primary financial system.    
 
The USDA has several feeder systems listed below.  Along with the transactions that are processed through the 
feeder systems, FMMI also sends files to the systems updating the SHCs.  Below are the current timelines when 
activity happens. 

  
 

 
 
 
 
 
 

Feeder systems interact differently with FMMI.  The one commonality is that if there is no available budget for the 
SHC provided, the entry will reject (payroll is the exception).  Rejected documents can cause delays in payments 
being issued and possible service interruption.  
 
SmartPay2 (US Bank) and WEX (Citi Bank) experience a very high number of rejects.  There are a few primary 
reasons for the issues:  
 Invalid/Missing BOC 
 Invalid/unfunded default code 
 Invalid/unfunded code used for reallocation 

 
Agency credit card transactions post in FMMI as either a ZW (SmartPay2) or ZX (Fleet Card) document 
types.  They post to the default Short Hand Code (SHC) and Business Object Code (BOC) that is on file for the 
cardholder.  If you need to change the default SHC or BOC you will do a reallocation (ZS document type) in 
Access Online to make the changes.  If the SHC is invalid or the budget amount is not sufficient to cover the charge 
either the ZW/ZX/ZS document can reject in FMMI.  The Local Agency Program Coordinator (LAPC) will contact 
the card holder to let them know of the reject.  To correct these rejects the program will need to increase funding on 
the SHC or provide a new SHC to the LAPC for this charge.  If the original ZW/ZX document rejects you will not 
be able to do a reallocation later in Access Online since the system cannot locate the original document.  Any 
changes then would have to be done on an SU document.  See Appendix B for reallocation guidance. 
 

List of APHIS Feeder Systems  
ETS2 / Concur  Government travel transactions 
SmartPay2 / WEX Purchase/fleet card processing 
WebTA/Payroll  Employee time & attendance/other employee payments 
MASC   Other USDA systems not specifically identified (i.e., ABCO, PACS, PROP)  
IAS   Integrated Acquisition System (Purchasing) 
CPAIS   Corporate Property Automated Information System (real property system)  
TRVL   Travel System for relocation authorizations and vouchers 

 
 

Feeders Inbound to FMMI 
GovTrip Real Time (web svc) 
IAS Real Time (web svc) 
SmartPay2 5:00 am (M-F) 
TRVL 5:00 pm (M-F) 
WEX ??? 

Published Shorthand Codes 
MASC (includes PROP, 
ABCO, TRVL) 

Daily            10:00 am 
                       3:00 pm 
                     11:00 pm 

GovTrip Daily            11:00 pm 
SmartPay2 / WEX Daily               7:30 pm 



Page 53 of 203 
 

 
IPAC Overview 

 
IPAC is a Treasury process/system used to move funds between federal agencies without processing manual 
payments or collections.  IPAC uses the Agency Location Code (ALC) through Treasury as we would use our bank 
account information to transfer funds to or from our bank account.   
 
NFC processes all IPAC transactions for the USDA, both intra-agency (i.e. USDA = INTR) and interagency (i.e. 
non-USDA = RONA), into FMMI. 
 

Interagency (IPAC) Collections = Treasury Transfer Funds = Sales Orders (RONA) 
Intra-Agency Collections = NFC Transfers Funds = Sales Orders (INTR) 
 
IPAC Payments = Purchase Orders 

 
IPAC Document Reference Number (DRN) - A unique identification number that is automatically assigned to 
each interagency transaction entered into the IPAC System.  

 
Example – IPAC Collection Document 

 
 

For more information regarding IPAC, please visit the following Treasury Link:  
http://tfm.fiscal.treasury.gov/v1/p6/c400.html 

http://tfm.fiscal.treasury.gov/v1/p6/c400.html
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Payroll Employee Level Detail Report 
 
Purpose 
The Payroll Employee Level Detail Report provides employee payroll details.   
 
Considerations 

• This report only shows payroll expense entries through WebTA (ZP docs), and will not show B2s affecting 
payroll or payroll processed any other way (ex. ePRES, State Dept). 

 
Report Type 
BI 
 
FMMI Role 
Accounts Payable, BI Reporter 
 
Instructions 
STEP 1: Go to Accounts Payable  > BI Payroll Reports > Payroll Employee Level Detail Report 

 

 
 
STEP 2: Variable entry screen for report will appear.  Enter the desired parameters to execute the report.   
 

 
 
STEP 3: To run by WBS element, enter the following data: 
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a. Fiscal Year = i.e. 2015 
b. Fiscal Period = i.e. 1 (October) 
c. WBS Element = i.e. AP.RA.RX01.72.0018 
d. Optional: click Check and if search criteria was entered correctly, a description will appear in the 

Description column 
e. Click OK to run the report 

 

 
 
STEP 4: The Report will generate and the layout can be modified to display as shown below, or to your preference. 

 

 
  

STEP 5: Commonly used additional features: 
f. Create/save variant 
g. Filter 
h. Drag and Drop 

 
 

STEP 6: To print PDF the report click Print Version and go to step 7 OR to export to Excel, click Export to 
Excel and go to step 8.   
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STEP 7: After Print Version is clicked, the following box will appear, click OK. 

 

 
 

 

 
 
 
 
STEP 8:  After Export to Excel is clicked, the following box will appear, click Open. 
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  Click Yes  and the report will automatically open in Microsoft Excel. 

 

  To enable editing, click the Enable Editing box shown 

 

*Note:  PPC is Pay Period Covered.  PPP is Pay Period Performed/Entered in PACS.  These will be different for a 
corrected TA. 
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GL Accounts within this report 
6100001101 BASE PAY - US NON-WAGE BOARD-FULL-TIME PERM 

6100001104 BASE PAY - US WAGE BOARD-FULL-TIME PERM 

6100001105 EMPLOYEE INDEBTEDNESS 

6100001109 TIME OFF AWARDS 

6100001121 BASE PAY - US NON-WAGE BOARD-FULL-TIME TEMP 

6100001131 BASE PAY - US NON-WAGE BOARD-PART-TIME 

6100001153 OTHER AWARDS 

6100001160 NIGHT DIFFERENTIAL 

6100001163 SUNDAY DIFFERENTIAL - NON-WAGE BOARD 

6100001164 SUNDAY AND NIGHT DIFFERENTIAL 

6100001170 OVERTIME - NON-WAGE BOARD 

6100001171 OVERTIME - WAGE BOARD 

6100001180 HOLIDAY PAY - NON-WAGE BOARD 

6100001183 LUMP SUM PAYMENTS - PERMANENT-NON-WAGE 
BOARD 

6100001205 FEHB - EMPLOYEE SHARE PAID BY AGENCY 

6100001274 TSP - GOVERNMENT-BASIC CONTRIBUTION 

6100001275 TSP - GOVERNMENT-MATCHING CONTRIBUTION 

6100002106 TRAVEL REIMBURSEMENTS 

6400001201 FICA - AGENCY CONTRIBUTION 

6400001202 FEGLI - AGENCY CONTRIBUTION 

6400001203 FEHBA - AGENCY CONTRIBUTION 

6400001204 CSRS 7% COVERAGE CODE 1 - AGENCY 
CONTRIBUTION 

6400001213 HIT - AGENCY CONTRIBUTION 

6400001214 TRANSITIONAL RETRMT CONTRI - CIVIL SERVICE 

6400001251 TRANS OASDI CONTRI - CIVIL SERVICE 

6400001264 FERS CONTRI - REGULAR 

6400001269 FULL OASDI CONTRI - FERS (L) 
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SO Overhead (OH) 

Overview 
SO OH is a percentage of eligible expenses.  Eligible expenses for OH include all billable expenses, less OH.  
(RRB includes all eligible expenses including Overhead.) 
 
FMMI SO OH Calculation 
       Total Eligible OH Expenses for Period 
x     OH Rate 
=     Overhead Charged on Account for Period 
 
SO OH Rates 
SO Overhead percentages range from 0% to 27.15%.   

• 0% OH rate would mean that all OH was waived in the agreement (this is rare and requires Administrator 
(or designee) approval).   

• 5.15% means that program OH in this agreement was waive and this amount is solely for MRPBS.   
• 16.15% means that regular OH is included in this agreement.   
• 27.15% means that regular OH plus pooled job costs are included in this agreement, this is WS specific.  
• Percentages in between any of the above signify some range of variation from the above listed standards. 

(WS Only)    
 
Pooled Job Costs (PJC) for WS 
Pooled job costs include any item of expense that may be directly identified with a particular project or program, 
and is distributed across all identifiable projects or programs to which it pertains (see Wildlife Services Policy, 
Chapter 2 Section 2.215, dated August 23, 2013). 
 
Initially in FMMI PJCs were intended to be picked up in the cost allocation cycle.  Cost allocation is a process in 
FMMI that moves certain indirect costs directly to accounts as billable expenses, based on established criteria in 
tables (i.e. spreads truck cost to multiple projects).  Later it was learned that cost allocation does not work with SOs 
and that is why PJCs are now included in the OH rate where needed.   
 
WS SO OH Split Example      SO OH Split Example 

1. MRPBS = 5.15%     1. MRPBS = 5.15% 
2. WS OH = 11%      2. Program OH = 11% 
3. WS PJC = 11% 

 
Direct vs Indirect Costs 

• Direct costs are those that are directly attributable to a project in full expense amount (i.e. program payroll, 
project supplies, etc). 

• Indirect costs are those that are not directly attributable to a project in full expense amount (i.e. Admin 
support, equipment repairs, etc).   

Please refer to Wildlife Services Policy, Chapter 2 Section 2.215, dated August 23, 2013 for more definitions and 
examples. 
 
 
*Note:  All portions of the FMMI WS SO OH rate are often referred to as just OH or indirect costs, but may also 
contain PJCs. 
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SO OH Reconciliation 
 
FMMI SO OH Calculation 
       Total Eligible OH Expenses for Period 
x     OH Rate on Account 
=     Overhead Charged on Account for Period 
 
Instructions 
STEP 1: To obtain the total eligible OH expenses for the period, run the LIACR Report for the appropriate  

a. WBS Element  
b. Posting Date Range 
c. Choose layout /AP OH RECON or /WS OH RECON for Wildlife Services 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: Multiply this total by the OH Rate on the account 
STEP 4: This total should equal the total OH charged on the account for the period 
 
Example 

AP.RA.RX36.72.0121 
04/01/14 – 04/30/14 
/WS OH RECON 

 
BP 14XX  (SO 6100009040) 

 
$  227.24  Eligible Expenses 
X  0.2715  OH Rate on SO 
$    61.69  OH Charged on Acct for Period 
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SO OH Charged 
 
Instructions 
STEP 1: To obtain the total OH charged for the period, run the LIACR Report for the appropriate: 

a. WBS Element 
b. Cost Element 6100980000 (OH GL)  
c. Posting Date Range 
d. Choose layout /AP OH CHRGD or /WS OH CHRGD for Wildlife Services 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: This total should equal the total OH charged on the account for the period 

 
Example 

AP.RA.RX36.72.0121 
6100980000 
04/01/14 – 04/30/14 
/WS OH CHRGD 
 
BP 14XX  (SO 6100009040) 
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SO OH Split 
 
Instructions 
STEP 1: To obtain the OH split for the period, run the LIACR Report as follows: 

a. AP.RA.*and AP.WS.* 
b. Cost Element 6100980000 (OH GL)  
c. Posting Date Range 
d. Choose layout /AP OH SPLIT  or /WS OH SPLIT for Wildlife Services 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: Review the results for the appropriate WBS element 
STEP 4: This should show the OH split for the account for the period 
 
*Note:  If you know all of your needed WBS elements, it would be best to limit the report to just those when 
running, or to use the wildcard trick (see FMMI Tips and Tricks) to lessen the results.  Otherwise, you may have to 
change the Further Settings to 20,000 lines or more to get to your account.  If you have to go this massive route, 
print to PDF and it will be searchable.   

 
Example 

AP.RA.* and AP.WS.* 
6100980000 
04/01/14 – 04/30/14 
/WS OH SPLIT 
 
AP.RA.RX36.72.0121 
BP 14XX  (SO 6100009040) 
Fund/Cost Center APWSER3636 (SO 6100009040) 
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*Note:  There is an OH Sender/Receiver Table in FMMI which defines the OH split based on Fund/Cost Centers, 
the OH Costing Sheet, and the OH Key.  Pat updates this table based on a spreadsheet she receives from BESB.  If 
you do not get the results you were expecting for the OH split, it is likely that the OH Sender/Receiver Table for the 
associated Fund/Cost Center is wrong.  Contact MRP.Billing.Requests@aphis.usda.gov for assistance.  (See 
screenshot below for an example of the table showing the OH split definition) 
 

 

 

 

  

mailto:MRP.Billing.Requests@aphis.usda.gov
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SO OH Earned 
 

Instructions 
STEP1: To obtain the OH earned by WBS Element, run the LIACR Report as follows: 

a. WBS Element (i.e. AP.RA.POOL.WS.ER36) 
b. Cost Element 6100980000 (OH GL)  
c. Choose layout /AP OH SPLIT or /WS OH SPLIT for Wildlife Services 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: This should show the OH earned for the WBS Element 
 
Example 
 AP.RA.POOL.WS.ER36 
 6100980000 
 /WS OH SPLIT 
 
 14XX 
 

 
 

*Note:  OH earned comes from the OH split (sender/receiver rules).  It shows as a negative expense in FMMI.  
This is where you see it in the SOF PTD as well, as a negative expense.   
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SO OH Spent 
 

Instructions 
STEP 1: To obtain the OH spent by WBS Element, run the LIACR Report as follows: 

a. WBS Element (i.e. AP.RA.POOL.WS.ER36) 
b. Choose layout /AP OH SPENT or /WS OH SPENT for Wildlife Services 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: This should show the OH spent for the WBS Element 
 
Example 
 AP.RA.POOL.WS.ER36 

/WS OH SPENT (NOTE:  This layout excludes OH earned.)  

 14XX 
 

 

*Note:  This report does not include Commitments or Obligations, which do affect budget availability.  Use the 
SOF PTD or ULO to review any Commitments or Obligations also affecting your account.   
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SO OH Available 
 

Instructions 
STEP 1: To obtain the OH availability by WBS Element, run the LIACR Report as follows: 

a. WBS Element (i.e. AP.RA.POOL.WS.ER36) 
b. Choose layout /AP OH AVAIL or /WS OH AVAIL for Wildlife Services 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: This should show the OH available for the WBS Element 
 
Example 
 AP.RA.POOL.WS.ER36 

/WS OH AVAIL  (NOTE:  This layout includes both OH earned and OH spent.)  

 14XX 
 

 

*Note:  This report does not include Commitments or Obligations, which do affect budget availability.  Use the 
SOF PTD or ULO to review any Commitments or Obligations also affecting your account.   
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LIACR Report Layouts 
 

These ECC LIACR Report layouts were created by FMD for both FMD, AP programs and WS use.   

We do want to collaborate to make these layouts as efficient and effective (into the best format) as possible for 
both parties.   

We do not want each program office to modify the layouts and save them either as the current layout name 
(overwrite) or a new layout name, without collaborating with FMD and the programs.  We all need to share the 
same layouts in order to save space and system resources, and keep them accurate.  If we end up with multiple 
layouts, there will be more to scroll through. Then, at some point we will likely have to clean this up and delete a 
bunch. 

For additional information regarding layouts and variants see FMMI Tips and Tricks. 
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Collections 

Payments to USDA APHIS Overview 
 
There are approximately 240,000 payments (primarily customer payments) to the USDA APHIS each year 
(approximately 20,000 per month).  On top of that, APHIS also posts payments for three additional USDA 
agencies.  USDA uses semi-automated posting processes (i.e. lockboxes).  For these reasons, it is critical that each 
payment is sent to the appropriate place using the correct payment processing data and including the proper 
remittance advice.  If any of these are not accurate, there is a good chance the payment either not being received 
by APHIS or being received and misapplied.   
 
 
Three important pieces to every APHIS Customer Payment: 

1. How the payment is sent    
Payments to USDA APHIS Instructions 

2. Where  the payment is sent    
APHIS Lockbox Instructions and Payments to USDA APHIS Instructions 

3. Remittance Advice Included on payment   
APHIS Remittance Advice Instructions 

 
 
 
Questions:  Contact the ABS Helpline for any assistance in making a payment to the USDA APHIS either by 
phone at 612-336-3400 or 877-777-2128 or by email at ABShelpline@usda.gov.   
 
 

  

mailto:ABShelpline@usda.gov
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Payments to USDA APHIS Instructions 

The procedures below are for payments to the USDA APHIS.  Payments are accepted via Check, Money Order, 
ACH, Wire Transfer, PayPal, Debit Card, and Credit Card.  Debit Card, Credit Card, PayPal, or ACH payments 
can be made at www.pay.gov 

 
Check or Money Order: Make payable to “USDA, APHIS.” Checks drawn from a foreign bank must 
say “Payable in US Dollars”. Mail your payment to the lockbox address 
 
Regular Mail:        
USDA, APHIS, Miscellaneous  
P.O. Box 979043                                         
St. Louis, MO 63197-9000 

Overnight mail only:  
US Bank  
Attn: Govt Lockbox      
1005 Convention Plaza  
St. Louis, MO 63197-9000     
Phone 314-418-6635 

 
Bank ACH: are processed through Remittance Express by the Federal Reserve Bank of Richmond.  
 
You will need the following information to remit a payment via ACH, if not using pay.gov:        

ABA:  051036706 
Name on Account: USDA, MRP, APHIS Account 
Number:  540021 

 
Wire Transfers: are processed through the Federal Reserve Bank of New York.  

You will need the following information to remit a payment via Wire Transfer: 
ABA:  021030004 
Name on Account: USDA, APHIS  
Account Number:  12403400 

 
DO NOT USE THE BANK SWIFT CODE for any Wire Transfers.  
This may cause your payment to be rejected. 
 
International Wire Transfers:  Must be sent through a US correspondent bank (i.e. third party or 
intermediary bank) before going to the Federal Reserve Bank of New York. The US correspondent bank 
information should be in bold. 

 
 
**NOTE: Any fees associated with the financial transaction chosen (i.e., Bank funds transfer, credit card, etc.) 
are the responsibility of the remitter. Please check with your financial institution for fee considerations.   
 
Questions:  Contact the ABS Helpline for any assistance in making a payment to the USDA APHIS either by 
phone at 612-336-3400 or 877-777-2128 or by email at ABShelpline@usda.gov.  You must leave a voicemail 
message when calling the phone number and the correct account manager will return the call. 

 
 
 
 
 
 
 
 
 

United States Marketing and Financial Financial 
Department of 
Agriculture 

Regulatory Programs Management 
Division 

O perations 
Branch 

 

mailto:ABShelpline@usda.gov
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USDA APHIS 

Remittance Advice Instructions 
 
The procedures below are for remittance advice for payments to the USDA APHIS.   
 
Remittance Advice: The following information must be included on your payment(s) and is crucial to 
ensuring the proper posting of your payment.  Determine your remittance advice based on your customer 
type below.   
 

Remittance Advice by Customer Type: 
 

• Advance (Down Payment) 
o WBS Element (ex. “AP.RA.xxxx.xx.xxxx”) 
 

• Reimbursable (non-OTC Accounts) 
o Bill Number only, if a bill exists (ex. “BD 300000789”) 

 
• Reimbursable – OTC Accounts 

o Customer Number (ex. “Cust No. 3361234”) 
 
Customer Types: 
 
Customer Payments 
 

Advance Payments – agreement includes payments in advance of services received. 
 
Reimbursable Payments – agreement includes payment after services are received. 
 
Over the Counter (OTC) Payments – may include, but not limited to the following: 

• customer  is paying at the time of service,  
• often small dollar amounts, and/or  
• one-time transactions.   

 
 
 
Questions:  Contact the ABS Helpline for any assistance in making a payment to the USDA APHIS either by 
phone at 612-336-3400 or 877-777-2128 or by email at ABShelpline@usda.gov.   
 
 
 
 
 
 

United States Marketing and Financial Financial 
Department of 
Agriculture 

Regulatory Programs Management 
Division 

O perations 
Branch 

 

mailto:ABShelpline@usda.gov
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USDA APHIS Lockbox Instructions 
 
The procedures below are for mailing in payments to the USDA APHIS via check or money order. 
USDA APHIS uses commercial bank lockboxes to route and post incoming payments.   
 
What is a Lockbox?  A service offered by banks to companies in which the company receives payments 
by mail to a post office box and the bank picks up the payments, deposits them into the company's 
account, and notifies the company of the deposits.  
 
Make checks or money orders payable to “USDA APHIS.” Checks drawn from a foreign bank must say 
“Payable in US Dollars”. Mail your payment to the lockbox address listed on your bill or form or refer 
to the below instructions for additional guidance.  
 
 
Remittance Advice: The remittance advice included on your payment(s) is crucial to ensuring the 
proper posting of your payment.  Determine your remittance advice based on your customer type and the 
associated instructions found on APHIS Remittance Advice Instructions.   
 
**CAUTION**    

APHIS General Lockbox and Collections Sort (in order) 
• Customer Account Number/ Billing Document Number 
• Down Payment 
• COD/ SHC 
• Unidentified 

 
 

 
Link to Lockbox Addresses: 
USDA APHIS Collection Types and Where To Send Them (Lockbox Addresses) 
 
 
Questions:  Contact the ABS Helpline for any assistance in making a payment to the USDA APHIS either by 
phone at 612-336-3400 or 877-777-2128 or by email at ABShelpline@usda.gov.   
 
 
 
 
 
 
 
 

United States Marketing and Financial Financial 
Department of 
Agriculture 

Regulatory Programs Management 
Division 

O perations 
Branch 

 

http://www.aphis.usda.gov/wps/portal/aphis/ourfocus/business-services/sa_financial_management/sa_financial_operations_branch/sa_billings_collections/ct_billings_collections/!ut/p/a1/lZFLb8IwEIR_S89Vshvb4OSYBwUH-m4a4ktlB_MokKCAKvHv6-aQG4H6tJa-Wc3MgoQ5yEr9bFbqtKkrtfv7y-EXEz4hFIlANiMYYvRJMc487wMtUFggfZ4QL7LAeDyKUDw9zF74NCU4Hdymj8fhhPEZIjKfoEiiScKDR0QxvE2PF16I1_Q5FDHILfL7t1eQIA_lZgEFpcYEA20cw0vmsCVHR3vad7gipaGLgPGAWKlst_eFb4G-dC3QYz8FudrV2p4ijzqfNnRYaeqvQDZmaRrTuOv6eIJ54x6Nasq1e1brunbLeg-FLYhfboDC-z9jp1crTTqj-agbD_ssy7Y6EN-Dbe4o7Z_F3S8uN0oz/?1dmy&urile=wcm%3apath%3a%2Faphis_content_library%2Fsa_our_focus%2Fsa_business_services%2Fsa_financial_management%2Fsa_financial_operations_branch%2Fsa_billings_collections%2Fct_collection_types
mailto:ABShelpline@usda.gov
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APHIS General Lockbox Process Flowchart 
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USDA, APHIS  

PAY.GOV Instructions 
 

Purpose 
Pay.gov is a collection tool for federal agencies to collect via credit card, debit card, PayPal, or ACH.  Please note 
that these collections may be entered directly into pay.gov either by internal staff or by external customers.   
 
Considerations 

• These instructions were specifically tailored to meet the needs of Wildlife Services customers.   
 
Instructions 
STEP 1:  Go to www.pay.gov 
 
STEP 2:  Click on FIND AN AGENCY 
 

 
 
STEP 3:  Click on “Agriculture (USDA): Animal and Plant Health Inspection Service (APHIS)” 
 

 
 
STEP 4:  Under Animal and Plant Health Inspection Service (APHIS) Customers, click on “Continue to the 
Form” 
 

 
 
 
 
 
 
 
 
 
 
 
 
STEP 5: Click on “Continue to the Form” 

http://www.pay.gov/
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STEP 6:  Fill out the Required Fields.   
 
At the bottom of the form you will see a question for “Service Provided By”, click on the drop-down box to get the 
menu and choose the Program for which you are paying. 
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STEP 7:  Enter your Billing Document Number(s) and Amount(s).   
 
For non-billed customers (i.e. OTC Sales), enter your Customer Account Number (7-digit number) and the Amount 
you are paying.  If the Customer Account Number is not known, enter something like “Wildlife Services-Nebraska” 
or the state you are doing business with for us to be able to research the payment. 
 

 
 
STEP 8:  Click on “Submit Data” 
 
STEP 9:  Choose the type of payment method you would like to use and click on “Next”  
 

 
 

STEP 10:  Enter all of the required payment information for the payment method chosen and click on “Review and 
Submit Payment” 
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STEP 11:  Review the payment information.  If all information is correct, put a check in the box next to the 
authorizing statement and click on “Submit Payment” 
 

 
 
STEP 12:  Either print or save a copy of the payment confirmation for your records.  This payment confirmation 
will be emailed to each email address submitted with the payment as well.   
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USDA APHIS 
 

DOWN PAYMENT REQUEST 
 

Date: 

Amount Requested:  $ 

WBS Element:   

BP: 

Down Payment Request Number:   

Agreement Number:   

 

In accordance with your agreement with the USDA, APHIS, Program filled in, we are required to collect 
funds prior to performing services.   

 

Please remit your payment along with a copy of this form to the address below, referencing the above 
WBS Element: 

 
USDA, APHIS, General 
PO Box 979043 
St Louis, MO  63197-9000 
 

If you have any questions regarding this request, please contact the APHIS office you are doing business 
with.      

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

United States Marketing and Financial Financial 
Department of 
Agriculture 

Regulatory Programs Management 
Division 

O perations 
Branch 
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United States Marketing and Financial Financial 
Department of 
Agriculture 

Regulatory Programs Management 
Division 

O perations 
Branch 

 

 
 

 
 
The USDA has implemented new procedures for Electronic Fund Transfers (EFT) through a Federal Reserve Bank.  The 
following information should be included with your payment.  We also request that you send an email or fax of this 
information to make sure we are able to identify the payment.  The information can be sent to fax (612) 336-3563, or email at 
ABShelpline@aphis.usda.gov.   
 
  - Organization Name / Company Name 
  - Account Information 
  - Purpose of payment 
  - Contact name and number 
 
Automated Clearing House (ACH) transactions are processed through Remittance Express by the Federal Reserve Bank of 
Richmond.  The process accepts information in the Cash Concentration and Disbursement (CCD) or the Corporate Trade 
Exchange (CTX) formats.  You will need the following information to remit a payment: 

 

ABA:           051036706 
Name on Account:  USDA, Marketing and Regulatory Programs (MRP), 
    Animal and Plant Health Inspection Service (APHIS) 
Account Number:   540021     

 
ACH 
Federal Reserve Bank of Richmond 
701 East Byrd Street 
Richmond VA  23219 
Tel:  (804) 697-8000 
 
Wire transfers are processed through the Federal Reserve Bank of New York.  You will need the following information to 
remit a payment.  
 
 ABA:    021030004 
 Name on Account  USDA, Animal and Plant Health Inspection Service (APHIS) 
 Account Number   12403400 
     
WIRE 
Federal Reserve Bank of New York 
33 Liberty Street 
New York, NY  10045 
Phone: (212) 720-5000 or (646) 720-5000 
 
International wire transfers, remitters should send through a US bank or a correspondent bank before going to the Federal 
Reserve.  The swift number cannot be used when using a US bank.   
Note:  Any fees associated with the transfer are the responsibility of the remitter; please check with your financial 
institution to make sure there are no surprises. 

 
USDA, APHIS 
ABShelpline Phone (612) 336-3400  
ABShelpline@aphis.usda.gov 

 
 

 

mailto:ABShelpline@usda.gov
mailto:ABShelpline@usda.gov
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APHIS Form 94 Instructions 
 
Record of Public Funds Received is a form APHIS uses to submit money collected by APHIS 
employees. Many APHIS employees, by virtue of their official capacity, will receive funds due to 
APHIS. These funds need to be documented on an APHIS Form 94 when a payment is sent in with no 
other posting information.  The purpose of this form is to ensure proper and timely posting of 
collections. 

 
Following are instructions for preparing the APHIS From 94. 

 
All Checks:  must be made payable to “USDA APHIS.” 

 
Foreign Checks:  checks drawn from a foreign bank must say “Payable in US Dollars.” 

 
Cash:  Do not send cash. If cash is collected, obtain a money order from a financial institution. 
Do not convert the cash to a personal check. Do not take the cost of the money order from the 
cash received. If necessary, use personal funds for the cost of purchasing the money order and 
claim reimbursement on an SF-1164, Claim for Reimbursement for Expenditures on Official 
Business.  

Do Not Hold Collections:  Forward funds collected on behalf of APHIS along with the original 
APHIS Form 94 to the address listed on the form in accordance with the following regulations.  
In general, send in checks by Thursday of each week, regardless of the amount accumulated, 
and on the day(s) when collections reach or exceed $5,000 total.  Regulations for collecting 
funds on behalf of the federal government can be found at Treasury Financial Manual, Volume I, 
Part 5, Chapter 2000- Depositing Domestic Checks and Cash Received in Over the Counter 
(OTC) Collections, Section 2055- Frequency of Deposits and 31 U.S. Code § 3302 - Custodians 
of money.  

Notification of Receipt of Collection:  Retain a copy of the APHIS Form 94 until you receive a 
receipted copy back from MRPBS collections staff.  MPRBS collection staff will return a copy of 
the APHIS Form 94 to the sender acknowledging receipt of the collection.  The receipted copy is 
for your records. 
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APHIS Form 94, Completion Instructions 
 

1. Transmitted Number – Used by the submitting office at their discretion. 
 
2. Date Forwarding – Enter date the APHIS Form 94 is being submitted. 

 
3. To – This is pre-populated with the correct remittance address for miscellaneous collections. 

 
4. From – Enter name and address including zip code of the submitting office. 

 
5. Date Received – Enter the date the money was received. 

 
6. For MRPBS-ASD use only – Leave this blank. 

 
7. Amount – Enter amount of the money received for each transaction. 

 
8. Remitter – Enter the name of the remitter. 

 
9. Purpose/FMMI Code – Enter the remittance advice following APHIS Remittance Advice Instructions. 

 
10. Total Amount Sent – Enter total of all the dollar amounts on the APHIS From 94. 

 
11. Sent By – Printed name, signature and phone number of the person submitting the APHIS Form 94. 

 
12. Title – Enter the title of the person sending the APHIS Form 94. 

 
13. Amount – Leave blank. 

 
14. Received By – Leave blank. 

 
15. Date – Leave blank. 

 
16. Title – Leave blank. 
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APHIS 94 Form 

 



Page 82 of 203 
 

Collections Reports  

Daily Collections Report 
 
Purpose 
The Daily Collections Report provides detailed information about each collection.  This report will display all 
accounting documents for Customer and Non-Customer collections.  The report is highly customizable to limit or 
expand the data you wish to see.   
 
Considerations 

• These instructions have been tailored for Wildlife Services to view their Sales Order collections.   
 
Report Type 
BI 
 
FMMI Role 
Accounts Receivable, BI Reporter 
 
Instructions 
STEP 1: Go to Accounts Receivable > BI Accounts Receivable Reports  > Daily Collections 

 

 
 
STEP 2: Variable entry screen for report will appear.  Enter the desired parameters to execute the report.  
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STEP 3: To run by Funded Program (WBS Element), enter the following data: 
a. Document Type = pre-filled (do not change unless you are certain of the exact doc type you need) 
b. Business Area = i.e. AP00 (APHIS) 
c. Fiscal Year = i.e. 2011; 2012; 2013; 2014; 2015 
d. Funded Program = i.e. AP.RA.RX36.72.0072 
e. Optional: click Check and if search criteria was entered correctly, a description will appear in the 

Description column 
f. Note:  If you know more specific data, you may use any of the other fields as well, (i.e. Check 

Number or Posting Date Range).   
g. Click OK to run the report 

 

 
 

STEP 4: The Report will generate and the layout can be modified to display as shown below, or to your preference 
 

 
 

STEP 5: To run by Customer Number, enter the following data: 
h. Document Type = pre-filled (do not change unless you are certain of the exact doc type you need) 
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i. Business Area = i.e. AP00 (APHIS) 
j. Fiscal Year = i.e. 2011; 2012; 2013; 2014; 2015 
k. Customer Number = i.e. 0003363845 
l. Click OK to run the report 

 

 
 
STEP 6: The Report will generate and the layout can be modified to display as shown below, or to your preference 

 

 
 

 
 
 
STEP 7: Commonly used additional features: 

m. Create/Save Variant 
n. Filter 
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o. Drag and Drop 
p. Save As/Open (Layout) 

 
STEP 8: To print PDF the report click Print Version and go to step 9 OR to export to Excel, click Export to 
Microsoft Excel and go to step 10.   
 

 
 

STEP 9: After Print Version is clicked, the following box will appear; Click OK and a PDF version will be 
available to print or save.   

 

 
 
STEP 10: After Export to Excel is clicked, the following box will appear, Click Open 

 

 
 
The following security message will appear, click Yes  and the report will automatically open in Microsoft 
Excel 
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To enable editing, click the box Enable Editing box shown 
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GL Accounts 
The following GL Accounts are used in the Daily Collection Report: 
 

 GL ACCOUNT  GL NAME  GL DESCRIPTION 
1010230000 Fund Balance With Treasury (FBWT-

COL Section 3/2) 
The aggregate amount of funds on deposit 
with the U.S. Department of the Treasury, 
excluding seized cash deposited 

1010330000 Fund Balance With Treasury (FBWT-
COL Section 3/3) 

The aggregate amount of funds on deposit 
with the U.S. Department of the Treasury, 
excluding seized cash deposited 

1310000000 Accounts Receivable   The amount due from others when the right 
to receive funds accrues. This may result 
from the performance of services, the 
delivery of goods, or court-ordered 
assessment. This account does not close at 
yearend. (Non Customer) 

1310900000 Accounts Receivable SD Recon Customer related Accounts Receivable 
1340000000 Interest Receivable  The amount of accrued interest receivable 

not otherwise identified. This account does 
not close at yearend.  (Non Customer)  

1340900000 Interest Receivable Reco Customer related Interest Receivable  
1360000000 Penalties and Fines Receivable The amount of penalties and fines on 

receivables that is not otherwise identified. 
This account does not close at yearend.  
(Non Customer) 

1360900000 Penalties and Fines Customer related Penalties and Fines  
1370000000 Administrative Fees Receivable  The amount of administrative fees receivable 

that is not otherwise identified. This account 
does not close at yearend. 
(Non Customer) 

1370900000 Administrative Fees Receivable-Other Customer related Administrative Fees 
Receivable 

2310000000 Liability for Advances and Prepayments   The amount of payments received in advance 
of performance of activities for which 
revenue has not been earned. This account 
does not close at yearend. 
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View a Billing Document 
 
Purpose 
Viewing a Billing Document in FMMI provides a process to verify information pertaining to the billing document, 
including payments (collections) posted to the billing document.  
 
Considerations 

• These instructions were specifically tailored to accommodate APHIS program billing and payment 
(collection) verification needs.   

 
Report Type 
NA 
 
FMMI Role 
Accounts Receivable, AR Evaluator 
 
Instructions  
STEP 1: Go to Accounts Receivable > AR Evaluation > Manage AR Documents > Display AR Document 
 

 
 

STEP 2: Enter the Bill Number (i.e. 3001150973) in the Document Number field and hit Enter.   
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STEP 3: The following screen will appear which shows the billing document. 
a. Note the following items: 

i. Clearing document number applied to the bill starts with __ signifies: 
1. 30 = bill was cancelled 
2. 24 = bill was paid with an IPAC payment 
3. 14 = bill was paid with a check, wire, ACH or plastic card 

 

 
 
b. Click on Display Document Header to show: 

i. Document Type 
ii. Entered by = FMMI User ID 

iii. Various Dates 
c. Click the green check box or the red X to close this screen 

 

 
 
 
STEP  4: Note the following payment details: 

c. Text Field –  
iii. Check, Wire, ACH number 
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Multiple documents or cleared bill later than received = blank or one document number 
only 

iv. IPAC Document = blank 
d. Payment Reference Field – 

iii. Check , Wire, ACH = the deposit ticket number 
iv. IPAC Document = IPAC Document Reference Number (DRN) – used to trace an IPAC 

payment   
 
STEP 5: To drill down into billing document , double click anywhere on the top line of the billing document 

 

 
 

The following screen will display.   

 
 

 
 
 
 
 
 
STEP 5: Go to Menu > Environment > Invoice Status and click on Invoice Status or press the Control Key and 
F10 at the same time 
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STEP 6: The following screen will appear which lists all the payments (collections) applied to this particular 
billing document.  Note the following items: 

a. Green Dots = the bill has been paid in full by the payments applied to it = the bill is fully cleared 
b. Red Dots = the bill has not been paid in full by the payments applied to it = the bill is not fully 

cleared 
 

 
 
 
 
 
 
 
 

STEP 7: To print this report as PDF click Menu > List > Print and go to step 8 (see step 9 to export to Excel). 
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STEP 8: After Print is clicked, the following box will appear.  Click the green check and a PDF version will be 
available to print or save.   

 
 

STEP 9: To export to Excel, click Menu > List > Export > Spreadsheet 
 

 
 
 
 
 
 
 
 
 
 

 
STEP 10: The following box will appear.  Enter the path and file name of your choice, and click Save .   
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STEP 11: The following box will appear, click Yes . 
 

 
 

STEP 12:  An excel version will be available to sort, print, or save.   
 

 
 

 
 
 
STEP 13: To save the file in Excel format, click File  > Save As .  Name the file again and use the drop down arrow 
to to change the Save As Type to Excel Workbook, and click Save .   

 



Page 94 of 203 
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SO Reports 

Reimbursable Orders Report 
 
Purpose 
The Reimbursable Orders Report provides the overview of each Sales Order in FMMI.  This report shows the 
Contract End Date, SO Amount, Total Expenses, Total Billed, and SO Available Amount, among other fields.  The 
report is highly customizable to limit or expand the data you wish to see.   
 
Considerations 

• These instructions were specifically tailored to accommodate SO verification needs.   
• This report does not reflect collections.   
• This report will not reflect transactions for your account which were posted incorrectly (ex. WBS 

FPDEFAULT).   
 
Report Type 
ECC 
 
FMMI Role 
Sales Order Reporter (Accounts Receivable, ECC) 
 
Instructions 
STEP 1: Go to Accounts Receivable > Sales Order Reports > Execute Sales Order Reports > Reimbursable 
Orders Report 

 

 
 
 
 

STEP 2: Enter the desired parameters in the variable entry screen to execute the report. 
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STEP 3: To run by Fund, Fund Center, and Funded Program (WBS element), enter the following data: 
a. Business Area = AP00 
b. Fund = i.e. AP001600AR 
c. Fund Center = i.e. APWSWR4949 
d. Funded Program (WBS Element) = i.e. AP.RA.* 
e. Layout = /Default or /Sales Order or /ZWSLAYOUT for Wildlife Services 
f. Click Execute to run the report 

 

 
 

STEP 4: The report will populate as shown below (this is the ZWSLayout) 
 

 
 

STEP 5: Commonly Used Additional Features 
g. Save as Variant 
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h. Filter 
i. Sort 
j. Subtotals 
k. Change Layout 

 
STEP 6: To print the report as PDF click Menu > List > Print and go to step 7 (See step 8 to export to Excel.) 

 

 
 
STEP 7: After Print is clicked, click the green check and a PDF version will be available to print or save. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
STEP 8: To export to Excel, click Local File   
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STEP 9: The following box will appear, select Spreadsheet and click the Green Check Box. 
 

 
 

 
 
 
 
 
 
 
 
STEP 10: The following box will appear, use the drop down menu to select where you want to save the file, name 
the file, and click Generate 
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STEP 11: You may (or may not) receive the following security message.  If you get this message, click Yes . 
 

 
 

STEP 12: Your screen will return you back to the ROR.  An Excel version of your file will be available to sort, 
print or save in the location you selected. 

 
STEP 13: Go to the location you selected to retrieve the file.  When opening the file, you may get the following 
message, Click Yes.   

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Page 100 of 203 
 

STEP 14: The file will open, as shown below.   
 

 
 

STEP 15: Go to File  >Save As , name the file again and use the drop down arrow to change the file type from 
Unicode Text to Excel Workbook, and click Save .  
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STEP 16: You may have to fix some formatting in order to manipulate the data in Excel.  The following items will 
cause incorrect filter results in Excel: 

l. Not selecting the entire area that needs to be filtered 
m. Merged cells (header info) 
n. Inconsistent cell formats (Number, Text, Date, etc.) 
o. Entirely blank rows or columns 

 
*Note:  This layout (/ZWSLAYOUT) does not work with the Pivot Table you may have used in the past.  If you 
prefer that method, you may follow those instructions or choose the correct layout (/DEFAULT) to use the Pivot 
Table.   
 

 
Reimbursable Billing Document TRD 

 
Purpose 
The Reimbursable Billing Document TRD provides the overview of the expenses posted to a WBS by major BOC 
group.  This report shows the expenses posted by BOC by month or quarter.   It will also show the overhead that is 
posted monthly.   
 
Considerations 

• These instructions were specifically tailored to accommodate verification of the expense detail on the new 
billing format.   

• This report does not reflect collections.   
• This report will not reflect transactions for your account which were posted incorrectly (ex. WBS 

FPDEFAULT).   
 
Report Type 
HANA 
 
FMMI Role 
Ad-hoc Analysis, BOBJ Ad-hoc Analysis 
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Instructions 
STEP 1: Go to Ad-hoc Analysis > Documents > Folders  > Public Folders > FMMI 
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Next go to APHIS > Accounts Receivable > HANA – Reimbursable Billing Document TRD 

 

 

 

 

• Click on Enter Value(s) for Fund AP001600AR 
• Click on Run Query 
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This report will take a little time to load: 

 

When the report first comes up, it will look like this: 
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From here you can search several ways.  You can check for an individual program code by inputing information in 
the User Prompt fields: 

 

• In the Enter Value(s) for Budget Period, remove the budget period(s) you don’t want to view or change it 
to the budget period you do want to view if it is not listed. 

• In the Enter value(s) for Funded Program, enter the WBS you want to view 
• Hit enter 

 

You can view view the Summary of expenses by quarter, the expenses posted by Month,  or check for overhead 
by month: 

 

The Summary of Expenses will be the default screen and you can scroll to the right to view the details: 

 

The summary by quarter will list the expenses broken down by major BOC.   Keep in mind, if this is an active 
agreement, the currect quarter might have expenses but they won’t be the final expenses for the quarter until the 
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quarter ends.   If an expense posts 10 minutes after you run the report,  you should be able to rerun the report a short 
time later and new a new total in the current quarter.    

 

 

 

The view the summary of expenses by Month: 

• Click on the Summary by Month tab 
• Scroll to the right to view the details: 
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The expenses will be posted by major BOC like in the Summary by Quarter view, however when you scroll to the 
right the column showing the Reimbursable Cost Element titles will disappear from view on months later in the 
year.    

 

To see if overhead was posted in a particular month: 

• Click on The OH Check by Month tab 
 

 

 

 

Another way to search is by choosing the WBS and Budget period from the drop down menus: 
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Once you find your WBS, you can check each of the tabs for the report information above just like you did when 
you searched using the User Prompt input fields on the left side of the screen. 
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If you have a whole stack of bills to verify and they all have the same Fund Center, you call pull up all WBS 
elements that have that Fund Center by choosing a Fund Center from the drop down menu:    
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You can also print or export your report: 

• Click on the Printer icon 
• Choose from the dropdown menu either Print or Export to PDF 

 

 
 

• Click on Open or Save 
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Budget 

APHIS AVC Budgets by Fund
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AVC Tables 
Budget Availability Control 

 
Purpose 
The AVC Tables in FMMI provide budget availability balances.   
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services budget authority 
verification needs.  

• There are two version of this report:   
o 9H Control Ledger – Budget authority for all expenses, including the amount reserved for 

Overhead  
o ZR Control Ledger – Budget authority for direct expenses only, not including the amount reserved 

for Overhead 
 
Report Type 
ECC 
 
FMMI Role 
Funds Management, ECC Reporting 
 
Instructions 
STEP 1: Go to Funds Management > Reports > Budget Preparation and Planning > Budget Availability 
Control 
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STEP 2: Variable entry screen will appear.  Enter the desired parameters to execute the report. 
 

 
 

STEP 3: To run by WBS element and all budget availability, enter the following data: 
a. Control Ledger = i.e. 9H 
b. Funded Program (WBS Element) = i.e. AP.RA.NA32.71.0346 
c. Click Execute to run the report 

 

 
 

STEP 4: The report will populate as shown below 
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STEP 5: To expand the report to see a breakdown by BP, click on the right facing arrow next to the line 
 

 
 

STEP 6: Click on the right facing arrow next to the BP line you would like to examine 
 

 
 
 
 
 
 
STEP 7: The report now shows as follows.  All Objects shows availability.    

d. Note the following items for the 9H Control Ledger:  
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i. Consumable Amount represents the total amount of budget authority for the agreement, 
including indirect expenses (OH), for the BP. 

ii. Consumed Amount represents the total amount spent, including indirect expenses (OH), 
for the BP. 

iii. Available Amount represents the total amount remaining to be spent, including indirect 
expenses (OH), for the BP.    

 

 
 

STEP 8: Verification of Consumable Amount, Consumed Amount, and Available Amount can be done using 
Display Sales Order, LIACR Report, and Status of Funds, Project to Date Report respectively, see examples below.   
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STEP 9: To check the Control Ledger ZR version of the table, click on the Back button.   
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STEP 10: In the Control Ledger field, change the selection to ZR and click Execute. 
 

 
 
STEP 11: The report will populate as shown below 

 

 
 

 
 
 
 
 
 
 
STEP 12: To expand the report to see a breakdown by BP, click on the right facing arrow next to the line 
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STEP 13: Click on the right facing arrow next to the BP line you would like to examine 
 

 
 
 
 
STEP 14: The report now shows as follows.  All Objects shows availability.    

e. Note the following items for the ZR Control Ledger:  
i. Consumable Amount represents the total amount of budget authority for the agreement, 

less indirect expenses, for the BP. 
ii. Consumed Amount represents the total amount spent, less indirect expenses and non-

reversed accruals, for the BP. 
iii. Available Amount represents the total amount remaining to be spent, less indirect expenses 

and non-reversed accruals, for the BP.    
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STEP 15: Verification of indirect costs consumed can be done using the Display SO (OH rate charged on the SO) 
and the LIACR Report (Eligible OH Expenses), see examples below.   
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Calculations 
9H Available Budget Authority     $27,411.00 
/ 1 + Overhead Rate                                  1.2715 
= ZR Available Budget Authority    $21,558.00 
 
9H Available Budget Authority    $27,411.00 
- ZR Available Budget Authority    $21,558.00 
Total Overhead to be Charged    $  5,853.00 
 
Total Overhead to be Charged    $  5,853.00 
- Total Overhead Charged    $  4,745.11 
Uncharged Overhead     $  1,107.89 
 
Indirect Cost Allocation (Based on $5,853.00 total) 
WS indirect 11% = $21,558.00 * .11 = $2,371.38 
WS pool 11% = $21,558.00 * .11 = $2,371.38 
PM 5.15% = $21,558.00 * .0515 = $1,110.24 
 
Findings for this example – Overhead is undercharged on this WBS and BP, based on eligible expenses. 
Period 2 OH is missing, period 11 OH is missing, and Period 12 OH is duplicated.    
 

 
 
STEP 16: Additional Items to Note: 

 
f. Over budget icon – may relate to any transaction(s) associated with the WBS and BP.   
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HANA – Analysis of Availability AP001600AR TRD 
 
Background 
Web Intelligence is the software that runs BOBJ or HANA BOBJ Reports.  This document discusses the Non 
Federal Reimbursable Invoices.  This report brings in multiple Fiscal Years but has set filters that allow you to 
choose only the Fiscal Years you wish to see.  This report shows collections, Estimated Collections, Receivables; 
Collections therefore it should be used only for fund AP001600AR. The report has multiple tabs to view your data 
in different ways. 
 
Roles 
BOBJ and/or BOBJ HANA Reporting Role 
  
Process 
1. Locate the HANA – ANALYSIS OF AVAILABILITY AP001600AR TRD in the Public Folders under the 

APHIS General Ledger Reports. 
Note:  For detailed instructions on locating APHIS Ad-Hoc reports see the “Opening a Previously Created 
BOBJ/HANA Ad-Hoc Report” document. 
 

 
 
2. The document will open with current data. 

 
 

There are multiple reports created from the data; the different reports can be seen by clicking the tabs at the bottom 
of the screen.   
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a. 

  

a. Total Report (HANA PROJECT TO DATE TOTAL COLLECTIONS AND OBLIGATIONS) is the 
first tab which summarizes the data by AP001600AR, breaking out the data by program and functional 
area.    The report totals the Fund. This is a high level report which brings in the estimated collections 
to agency for that line item.   

• Total Obligations calculates the totals by adding together the Total Commitments, Total 
Account Recoveries, Total Undelivered Orders, Total Expenditures and Total 
Disbursements.  

• Total PTD Availability is Total PTD Collections minus Total Obligations.   
o A negative Total PTD Availability means that there have been more Obligations 

then Collections.     
o A positive Total PTD Availability means that there have been more Collections 

then Obligations. 
• Total Open Sales Order Amount is Total Sales Order minus Total PTD Actual Collections.   

o A positive amount in the “Total Open Sales Order Amount” column means that 
the estimate might need to be decreased. 

o A negative amount in the “Total Open Sales Order Amount“column means that 
the estimate needs to be increased.  Collections have already occurred and this 
column should eventually be zero 

Note:  This is the report format that is shown first when you run the report. 
 
 
 
 
 

Body of the Report 

Report 
Layout Tabs 

  
 

Report may default 
to Available 
Objects 

<Click> on Input 
Controls which allows 
you to filter the data. 
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b. 

   
  

b. Total Analysis (HANA Total by Fund Center and Funded Program) - breaks out the data by the 
Program, Fund, Functional Area, Fund Center and Funded Program.  The report subtotals Program and 
Fund.  This report allows you to see all activity that occurred by for a certain reimbursable for a 
program. Total Availability is Total Actual Collections minus Total Obligations.    You can use the 
input controls on the left to filter to just a certain Fiscal Years, Budget Periods, Programs etc., that you 
are interested in reviewing. 

Make sure you have clicked on this icon which will activate the input control.  Please remember 
input controls only work for the report you are working on.  If you move to another report/tab then you 
will need to use the input control to filter that tab individually.  To remove an input control <click> on 
All Values and Ok to remove an input control individually, or the Reset button at the top of the list of 
Input Controls. 

 
 
 
 
 
 
 
 
 
 
 
 
 

If you do not see the Input Controls <click> 
on the icon on the left hand side. 

Input Controls 
which allow you to 
filter the data. 

Reset Buttons that 
resets all input 
controls back to 
All Values. 



Page 125 of 203 
 

c. 

 
c. Report by Program (HANA Report by Program) -  breaks out the data by the Program, Budget Period, 

Fund, Functional Area, Fund Center, and Funded Program.  The report subtotals by the Program, 
Functional Area and Grand total.  This report allows you to see all the programs that had activity at a 
detailed master data level.  

d. 

 
d. Report by Budget Period (HANA Report Subtotaled by Budget Period) - breaks out the data by the 

Fund, Budget Period, Functional Area, and Program.  The report subtotals by the Budget Period, and 
Program.  This report allows you to see all the programs that had activity at each Budget Period.   
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e. 

 
 
e. Report by Detail Expenditures (HANA Report by Detail Collections and Expenditures) - breaks out the 

data by the Fund, Budget Period, Functional Area, Fund Center, Funded Program and Program.  The 
report subtotals by Fund Center, Budget Period, Program and Grand Total.  This report allows you to 
see all the programs that had activity grouped by Budget Period.  The data is broken out by Total Sales 
Order, Total PTD Actual Collections, Total Open Sales Order Amount, Total Account Recovery, Total 
Commitments, Total Undelivered Orders, Total Expenditures, Total Disbursements, Total Obligations, 
and Availability. 

f. 

 
f. Download – contains all the available fields for download Program, Budget Period, Fiscal Year, Fund, 

Functional Area, Funds Center, Funded Program, 3BOC, Total Sales Order, Total PTD Actual 
Collections, Total Open Sales Order Amount, Total Account Recovery, Total Commitments, Total 
Undelivered Orders, Total Expenditures, Total Disbursements, Total Obligations, and Availability.  
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The report contains no subtotals but does contain a grand total. This allows you to download the data to 
excel to easily manipulate the information. 
 
To Export the tab: 

 
Go to the Export tab under file and then the Export Current Report As.  <Click> on the Excel 2007 if 
you want data for a download.   If you want Every tab in the report then you will want to Export 
Document As.   

g. 
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g. The final tab is the Notes which tells you more about the document; how the fields are created and 
anything else that might help the end user. 
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Over Budget Issues 
 

Common Over Budget Issues 
 

• Cannot post additional expenses 
o OH (indirect expenses) will not post 
o Direct expenses will not post 

 
• Cannot close SO or associated master data elements  

 

Reasons and Resolutions for Over Budget Issues (“Budget Exceeded” errors) 
 

• SO BP line amount has been reduced (check Display SO, Doc Flow, and/or manually recalculate AVC 
Tables) 

o Request change of SO BP line amount to MRP.Billing.Requests@aphis.usda.gov (where justified) 
 

• Expenses overspent or posted to wrong account (check ROR, manually recalculate ZR AVC Tables, 
LIACR and/or Payroll Detail Report) 

o Modification of Agreement, Expenditure Adjustment for direct expenses, or Request Additional 
Collection(s), as warranted 
 

• OH (indirect expenses) overspent (can be any associated OH account) (manually recalculate ZR AVC 
Table, check LIACR and/or SOF PTD) 

o Expenditure Adjustment for indirect expenses 
 

• Open Unneeded Obligations absorbing budget (check ULO or SOF PTD) 
o Deobligate unnecessary open obligations 

 
• Accruals not reversed 

o Follow up on non-reversed accruals 
 

• ROWA, additional reasons/resolutions: 
o Collection not received (check Doc Flow, ROR, and/or Daily Collections) 

 Request collection from customer 
o Collection not cleared (check Doc Flow and/or ROR) 

 Follow up on why it is uncleared, as needed, with Lucy.A.Currie@aphis.usda.gov  or 
MRP.Billing.Requests@aphis.usda.gov   

o Collection not posted properly (check Doc Flow, ROR, and/or Daily Collections) 
 Follow up with Lucy.A.Currie@aphis.usda.gov  for a collection modification 

o Additional uncleared, unnecessary DPRs (check Doc Flow and ROR) 
 Follow up with MRP.Billing.Requests@aphis.usda.gov if there are any additional 

uncleared, unnecessary DPRs 
 

• INTR – Intra-agency – USDA, additional reasons/resolutions: 
o PO not entered, not approved (i.e. parked), or increased to appropriate funding 
o Second line was created on PO rather than increasing the first line 

 Contact David.L.Santelman@aphis.usda.gov for assistance on INTR PO issues 
 
*NOTE:  If over budget issues prevented OH from posting in a prior period, after you have resolved the over 
budget issue(s), you will need to send a request to MRP.Billing.Requests@aphis.usda.gov to rerun OH for 
the prior period(s) missed.   
 

mailto:MRP.Billing.Requests@aphis.usda.gov
mailto:Lucy.A.Currie@aphis.usda.gov
mailto:MRP.Billing.Requests@aphis.usda.gov
mailto:Lucy.A.Currie@aphis.usda.gov
mailto:MRP.Billing.Requests@aphis.usda.gov
mailto:David.L.Santelman@aphis.usda.gov
mailto:MRP.Billing.Requests@aphis.usda.gov
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Example - Over Budget Issue on OH Account 
 

When sales orders are set up, a portion from each SO is set aside into the overhead pot of funds.  The “budget” in 
the overhead pot of money that was created by the sales orders can be seen, however you don’t actually have those 
funds until expenses are posted and the overhead is generated and “earned.”     When billings staff tries to reduce a 
sales order and there are more expenses posted to the overhead WBS than was earned, they will get a “budget 
exceeded overhead ledger” error.    
 
For example, if there are four sales orders with the amounts below 
 

 
Direct expense portion overhead portion total SO amount 

SO 1 $9,000.00 $1,000.00 $10,000.00 
SO 2 $8,000.00 $900.00 $8,900.00 
SO 3 $15,000.00 $1,500.00 $16,500.00 
SO 4 $7,000.00 $700.00 $7,700.00 

    total $39,000.00 $4,100.00 $43,100.00 
 
You should see a “budget” of $4100 in the overhead pot of funds.     
 
Then at some point, one SO is reduced in amount for any reason: 
 

 
Direct expense portion overhead portion total SO amount 

SO 1 $7,200.00 $800.00 $8,000.00 
SO 2 $8,000.00 $900.00 $8,900.00 
SO 3 $15,000.00 $1,500.00 $16,500.00 
SO 4 $7,000.00 $700.00 $7,700.00 

    total $37,200.00 $3,900.00 $41,100.00 
 
Now there is only a “budget” of $3900.   If more expenses are posted to the overhead WBS than that $3900, 
billings staff will get a budget exceeded error.    Because there are more expenses on that overhead WBS than that 
$3900 they will be unable to reduce the sales order.     In the above example, if there were $4100 in expenses 
posted to the overhead WBS, billings staff would receive a “budget exceeded overhead ledger” of $200.     
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Unliquidated Obligations (ULO)  

Overview 
 
Purpose 
The APHIS ULO process is the process APHIS uses to manage and report on unliquidated obligations.  
Unliquidated obligations over 12 months of no activity require justification.   
 
Obligations do affect budget availability.  It is important to clean these up as soon as reasonably possible.   
 
Anyone that has responsibility for the ULO review and certification should have access to the U Drive for 
additional ULO information and instructions.  Anyone who is responsible for the ULO review and certification but 
does not have access to the U drive should contact Kraig Peterson, the APHIS ULO lead.   
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Unliquidated Obligations (ULO) Detail Report 
Purpose 
The ULO Report provides details on unliquidated obligations.  This report will display obligations document details 
including vendor, days since last activity, years old, and amount.   
 
Considerations 

• These instructions have been specifically tailored to Wildlife Services. 
 

Report Type 
BI BEx 
 
Role 
General Ledger Management, BI Reporter 
 
Instructions 
STEP 1: Go to General Ledger Management > BI General Ledger Reports > Un-liquidated Obligations 
Detail Report 
 
 

 
 

STEP 2: Variable entry screen will appear.  Enter the desired parameters to execute the report.   
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STEP 3: To run by Fund Center, enter the following data: 
a. Business Area = i.e. AP00 (APHIS) 
b. Fiscal Period/Year = i.e. 001/2014 (Oct 2014) 
c. Fund Center = i.e. APWSER2828 
d. Optional:  Click Check to verify that the information was entered correctly.  If entered correctly, a 

description will appear in the Description column.   
e. Click OK to run the report.   

 

 
 

STEP 4:  The report will generate and the layout can be modified to display as shown below, or to your preference 
for your ULO monitoring purposes.   
 

 
 

STEP 5: *Note :  You will see messages regarding the conditions in the report which you can ignore.  Conditions 
are the limits that were entered to create the report.  If you click on Settings you can click on the Conditions tab and 
see what conditions are active. 
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ULO 12 Months No Activity 
 
STEP 6: To sort based on 12 months of no activity, first click on Filter. 

 

STEP 7: The screen will refresh to display the following.  Click on the drop down box under Last Activity Date, 
and click edit. 
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STEP 8: Click on the drop down box for Show Tool and select Value Ranges. 
 

 
 

STEP 9: Click on the drop down box for Operator and select Lower or Equal. 
 

 
 

STEP 10: Enter the date one year back from the date you are reporting on in the From field, and click Add to insert 
the limit, and click OK to set the filter.   

f. Ex: If we are pulling information based on February 28, 2013, then you would select on February 
29, 2012 in order to see obligations that have not had activity in 12 months. 
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STEP 11: Your report will refresh similar to one of the below options.  Note the following: 
g. The first screen with data represents obligations which have had no activity in the last 12 months.   
h. The second screen with no data represents that there are no obligations which have had no activity 

in the last 12 months.   
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Request Collection Modification 
 
Purpose 
Collection Modifications are an adjustment process used to recode the customer and/or master data elements 
assigned to a particular collection transaction.   
 
Instructions 
STEP 1: Email request to Lucy.A.Currie@aphis.usda.gov.  Email should include: 

a. Subject – “Collection Modification Request – Doc Number 1200001234 - $250.00” 
b. Body – include the following:   

i. Incorrect Collection Posting Document Number (i.e., 1200001234) 
1. See Daily Collections for detailed instructions.  Document numbers for collection 

postings are 10 digit numbers beginning with 12, 13, or 14. 
ii. Justification for Request (i.e., Should be Advance Collection) 

iii. Correct Posting Information: 
1. Customer Type (i.e., Advance, Reimbursable, or OTC) 
2. Customer Number (i.e., 3301234) 
3. WBS Element  (i.e., AP.RA.xxxx.xx.xxxx) 
4. BP (i.e., 14XX) 
5. Amount (i.e., $250.00) 

 
Example  

 
 

mailto:Lucy.A.Currie@aphis.usda.gov
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Request Customer Refund 
 
Purpose 
Customer refunds are a process used to refund the remaining balance on a customer account after services are 
completed and all financial transactions have posted to the account.   
 
Instructions 
STEP 1: Email request to Lucy.A.Currie@aphis.usda.gov.  Email should include: 

c. Subject – “Customer Refund Request – Cust. No. 3301234 - $565.25” 
d. Attachment – Completed Request for Customer Refund Form 

 

  

mailto:Lucy.A.Currie@aphis.usda.gov
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Debt Management 
 

Process 
When payment of a bill is not received within 30 days of issuance, the debt is considered past due and a process is 
initiated within FMMI and APHIS to collect that money.  The following is a timeline of the debt management 
process. 
 
Day 1 – This is the Bill Date. 
 
Day 30 – Bill payment is due. 
 
Day 31 – This is the day interest begins to be assessed.  In 2015, interest is 1% per annum.  The interest rate is 
mandated by U.S. Treasury.)  NOTE:  FMMI is not currently set up to have past due notices, interest, or penalties 
automatically generated.  This will occur at a future date.  
 
Day 45  –  An Accounts Receivable Specialist in FMD will contact the customer requesting payment.  
 
Day 60 –  A letter of intent is manually sent to past due customer from Accounts Receivable Specialist in FMD.   
 
Day 91 – Penalty charges are now assessed.  The charges are retroactive to the due date.  Per U.S. Treasury 
regulations, the penalty is 6% per annum.)  NOTE:  FMMI is not currently set up to have past due notices, interest, 
or penalties automatically generate.  This will occur at a future date.  
 
Day 120 – The debt is now 90 days past due.  If there has been no response to the letter of intent, the debt will be 
prepared to send to the U. S. Department of Treasury.  The specialist will inform the program if services to the 
cooperator should be suspended.  The specialist will confer with the analyst on what has occurred and how to 
proceed.  The specialist will begin preparing the debt for referral to U.S. Treasury for cross servicing.   
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APHIS issues Bill or Statement 

Open receivable created in FMMI 

First Past Due Notice sent on collection due date 

Second Past Due Notice sent 30 days after first notice 

Interest assessed 31 days past collection due date 

Contact vendor; debt is 45 days old –by phone/letter 

Third Past Due Notice sent 30 days after second notice 

Interest assessed 61 days past collection due date 

DMT sends letter  

Interest and penalty assessed 91 days past due 

No payment 

No payment 

No payment 

No payment 

No payment 

Debt referred to Treasury for cross-
servicing 120 days past due 

DMT sends letter 

Debt Management Process Flow Chart 
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Debt Management Regulations 
 

Regulation References: 
Debt Collection Improvement Act of 1996 
Public Law 104-134 
Seven purposes: 

1. To maximize collections of delinquent debts owed to the Government by ensuring quick action to enforce 
recovery of debts and the use of all appropriate collection tools. 

2. Minimize the costs of debt collection by consolidating related functions and activities and utilizing 
interagency teams. 

3. To reduce losses arising from debt management activities by requiring proper screening of potential 
borrowers, aggressive monitoring of all accounts and sharing of information within and among Federal 
agencies. 

4. To ensure that the public is fully informed of the Federal Government’s debt collection policies and that 
debtors are cognizant of their obligations to repay amounts owed to the Federal Government. 

5. To ensure that debtors have all appropriate due process rights, including the ability to verify, challenge and 
compromise claims and access to administrative appeals procedures which are both reasonable and protect 
the interest of the United States. 

6. To encourage agencies, when appropriate to sell delinquent debt, particularly debts with underlying 
collateral 

7. To rely on the experience and expertise of private sector professionals to provide debt collection services to 
Federal agencies. 

 
This law provides that any non-tax debt or claim owed to the United States that has been delinquent for a period 
120 days shall be turned over to the Secretary of the Treasury for appropriate action to collect or terminate 
collection actions on the debt or claim. 
 
Section 5 of the DATA Act amends 31 U.S.C. 3716(c)(6) and now requires agencies to refer to Treasury valid, 
delinquent nontax debts for the purpose of administrative offset (TOP) at 120 days - 60 days earlier than the 
previous 180-day requirement. 

 http://fiscal.treasury.gov/fsservices/gov/debtColl/rsrcsTools/debt_DATA_act.htm   

 
31 USC 7701 
The head of each Federal agency shall require each person doing business with that agency to furnish to that agency 
such person’s taxpayer identification number.  A person shall be considered to be doing business with a Federal 
agency if the person is in a relationship with the agency that may give rise to a receivable due to that agency. 
 
7 CFR 3.34 (USDA Debt Management) 
USDA creditor agencies must attempt to collect interest, penalties and administrative costs on any delinquent debt 
owed to the U.S. in accordance with 31 CFR 901.9, or according to written documentation constituting the basis of 
the debt, or under any guidelines issued by the Assistant Secretary for Administration or by the creditor agency’s 
fiscal officer.    Agencies will assess a penalty of 6% a year on any unpaid debt balance delinquent for more than 90 
days.  
 
Separation of Duties for Collection Officer: 
GAO Policy and Procedures Manual for Guidance of Federal Agencies.   Title 7 Fiscal Procedures, 
Chapter 5.2B Control over Collections – Separation of Duties for Cash Receipts:   
In accordance with the internal control standard for separation of duties, persons responsible for handling cash 
receipts should not participate in the accounting or operating functions relating to any of the following: 

http://fiscal.treasury.gov/fsservices/gov/debtColl/rsrcsTools/debt_DATA_act.htm
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1.   Shipping of goods and billing for goods and services. 
2. Controlling accounts receivable and subsidiary ledgers. 
3. Preparing and mailing statements of balances due. 
4. Authorizing and approving credits for returns and allowances or adjustments of amounts due. 
5. Preparing cash reconciliations. 

 
Federal Claims Collection Standards (FCCS) – Dept of Treasury & Justice 
 
31 CFR 901.1 Aggressive agency collection activities 
Federal agencies shall aggressively collect all debts arising out of activities of that agency.  Collection activities 
shall be undertaken promptly with follow-up action taken as necessary. 
 
31 CFR 901.2 Demand for Payment 
Written demand informing the debtor of basis for indebtedness and rights of the debtor; standards for imposing any 
interest, penalties or administrative costs; date by which payment should be made to avoid late charges and 
enforced collection; and agency contact person or office shall be made promptly upon a debtor of the U.S. in terms 
that inform the debtor of the consequences of failing to cooperate with the agency to resolve the debt.  The FCCS 
states that generally one demand notice should suffice but USDA has established the use of 3 demand notices in its 
financial system. 
 
31 CFR 901.6 Suspension or revocation of eligibility for loans and loan guaranties, licenses, permits, or 
privileges. 
In non-bankruptcy cases, agencies seeking the collection of claims should consider the suspension or revocation of 
licenses, permits, or other privileges for any inexcusable or willful failure of a debtor to pay such a debt in 
accordance with the agency’s regulations or governing procedures. 
 
31 CFR 901.9 Interest, penalties, and administrative costs 
Agencies shall charge interest, penalties and administrative costs on debts owed to the U.S. pursuant to 31 USC 
3717.   An agency shall mail or hand-deliver a written notice to the debtor, at the debtor’s most recent address 
available to the agency, explaining the agency’s requirements concerning these charges.  Agencies shall charge a 
penalty, pursuant to 31 USC 3717(e)(2), not to exceed 6% a year on the amount due on a debt that is delinquent for 
more than 90 days. 
 
31 CFR 902.2 Basis for Compromise 
Agencies may compromise a debt if the Government cannot collect the full amount because:  (1) The debtor is 
unable to pay the full amount in a reasonable time, as verified through credit reports or other financial information; 
(2) The Government is unable to collect the debt in full within a reasonable time by enforced collection 
proceedings; (3) The cost of collecting the debt does not justify the enforced collection of the full amount; (4) There 
is significant doubt concerning the Government’s ability to prove its case in court. 
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New RRB Bill Format 
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APHIS Completed Form W-9 
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The ABS Helpline                                        
 

PHONE:  612-336-3400 or 877-777-2128 

ABS Helpline is a toll free number that any customer can call when they have questions regarding their USDA 
customer account.  This phone number is listed on all of our dunning notices, past due letters, and monthly 
statements.  This line has a recorded message instructing callers to leave their name, phone number, customer 
account number and brief message.  The voicemail messages are picked up by members of the APHIS and Non-
APHIS Account Receivable team members.  The messages are written up and distributed to the correct FMD 
employee that handles the customer account.  The program offices should not call this number - they should contact  
the proper specialist in FMD directly.  There is no zero out option on the ABS Helpline.  A voicemail message must 
be left in order to receive a response from FMD.   

  

EMAIL:  ABSHELPLINE@USDA.APHIS.GOV    

Emailing the ABS Helpline is another method for our customers to contact us about their account or bill questions.  
All staff members of the APHIS and Non-APHIS Accounts Receivable teams check the email helpline on a regular, 
hourly basis.   

Both the voicemail and email ABS Helplines are answered by Minneapolis Financial Operations Branch. 

Close Sales Order 

Zero Dollar Balance 
Sales Orders should be closed when either the POP has expired or when all work is completed if before the end of 
the POP.    Closed means “zero” balance, which means the SO amount, the expenses and the billed amount are 
equal. 

Instructions 
1. Ensure all collections and expenses are posted correctly (see Daily Collections and LIACR for detailed 

instructions) 
 

2. Verify OH was captured on all periods with expenses (see LIACR for detailed instructions) 
 

3. Verify All Expenses Have Been Billed (see ROR for detailed instructions) 
 

4. Request SO Line Amount be Reduced to Consumed Amount (see ROR for detailed instructions) 
a. Email to MRP.Billing.Requests@aphis.usda.gov 

 
5. Ensure Zero Balance (see SOF PTD for detailed instructions) 

a. Advance SO – Request Refund if needed (see Refund Request for detailed instructions) 
i. Email to Lucy.A.Currie@aphis.usda.gov or Jennifer.L.Elias@aphis.usda.gov 

 
6. Reconcile Account Zero Balance (WBS and BP = SO Line Item) (see SOF PTD for detailed instructions) 

 
7. Check Doc Flow for any uncleared items (see View a SO, Doc Flow for detailed instructions) 

mailto:ABSHELPLINE@USDA.APHIS.GOV
mailto:MRP.Billing.Requests@aphis.usda.gov
mailto:Lucy.A.Currie@aphis.usda.gov
mailto:Jennifer.L.Elias@aphis.usda.gov
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a. Research and resolve any uncleared items – contact appropriate party by doc type (i.e. RV doc 
contact Billing group) 

 
8. Request to manually clear customer line items, F32 (see Customer Line Item Display for detailed 

instructions) 
a. Email to Katrina.J.Sopcyk@aphis.usda.gov  

 
Examples of ROR in SO Close 
 
Example 1 
 

 
 

• The Earned Unbilled column shows positive balance 
• Total Expenditures equals Sales Order Amount 
• Determine whether amount in Earned Unbilled needs to be billed 

* Note, these examples are from converted FY11 sales orders and may have issues due to conversion 
 
Example 2 
 

 
 

• Expenditures are less than Sales Order amount 
• Earned Unbilled shows a negative number which indicated a credit amount 
• Determine if credit amount needs to be refunded 

 
Example 3, Converted Issue 
 

 
 
 Sales Order amount and expenditures equal 
 Earned Unbilled amount indicated whole billed amount of expenses has been removed 
 Determine whether a refund is needed or if all the expenses need to be SU’d back on. 

*Note, with rules in FMMI now, we couldn’t have an SO of zero if there is a positive billed amount 
 
 
 
 
 
 
 

mailto:Katrina.J.Sopcyk@aphis.usda.gov
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Example 4 
 

 
 

• Expenditures and Billed amount match 
• Earned Unbilled amount is zero 
• Sales order amount is larger than the billed and Expenditures and billed amount 

o Send in a SO Request form requesting the SO be reduced to Billed and Expenditure amount 
 

Request Close of Shorthand Codes  
 
Purpose 
Closing SHCs prevents further activity from posting to those SHCs.   
 
Considerations 

• SHCs for projects that are not complete SHOULD NOT be closed.   
• MASC must remain active for at least one year to allow documents such as a corrected T&A and PROP 

depreciation to process through. 
• Closing SHCs in FMMI does not remove the code from the feeder system.  That process is individual to 

each feeder system.  For WebTA timekeepers can remove SHCs.   
 
Instructions 

1. Designated program staff should send an email to APHIS-Master Data Requests 
(Master.Data.Requests@aphis.usda.gov) with the list of SHCs to be deactivated (no reference to feeder 
systems needed).   

2. The lists will be submitted to NFC for processing, deactivating the SHC from all feeders except MASC. 
 

Shorthand Code Close Verification 
 
Purpose 
To verify if a SHC request for (activation or) deactivation has been successfully completed in FMMI.   
 
FMMI Role 
Interface Table Maintenance Evaluator 
 
Instructions  
STEP 1: Go to Interface  Table  Maintenance > Shorthand Code  Evaluation > Shorthand Code  Table  > View 
Shorthand Code 

 

mailto:Master.Data.Requests@aphis.usda.gov
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STEP 2: Enter the desired parameters in the variable entry screen to execute the reports.   
 

 
 

STEP 3: To search by WBS, enter the following data:   
e. Agency = 34 (APHIS) 
f. WBS Element = i.e.  AP.RA.RX47.72.0080 
g. Click Execute to run the report 
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STEP 4: The report will populate as shown below 
h. Note the following items: 

i. Sys ID 
ii. Status 

1. Active = Open 
2. Deactivated = Closed 

 
 

Request Close of WBS Elements (Where Applicable) 
Purpose 
Closing WBS Elements prevents further activity from posting to those WBS Elements.  
 
Considerations 

• WBS Elements for projects that are not complete or that will be reused on future projects SHOULD NOT 
be closed.   

 
Instructions 
Designated program staff should send an email to APHIS-Master Data Requests 
(Master.Data.Requests@aphis.usda.gov), stating that the code will no longer be needed, the account balance is 
zero, and the account has been fully reconciled.   
 

WBS Elements Close Verification (Where Applicable) 
 
Purpose 
To verify if a WBS Elements’ request for deactivation has been successfully completed in FMMI.   
 

mailto:Master.Data.Requests@aphis.usda.gov
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FMMI Role 
Cost Management Evaluator 
 
Instructions  
STEP 1: Go to Cost Management > Cost Management Evaluation > Display Project > Project Builder  
 

 
 

STEP 2: To search by WBS go to Menu > Project > Open 
 

 
 

STEP 3: The following screen will appear.  Enter the following: 
a. WBS Element – i.e. AP.TF.VSCV.19.0098 
b. Click the green check box to execute 

 

 
 
STEP 4: The report will populate as shown below.  Note the following items: 
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c. System Status 
i. REL ACPT = Open 

ii. CLSD or CLSD ACPT = Closed 
iii. REL LCKD-ALL = Locked (okay to use when minor error prevents Close status) 
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Customer Line Item Display 
 
Purpose 
The Customer Line Item Display provides a process to verify information pertaining to the customer account and 
respective SO, including identifying items that are not fully cleared and preventing the SO from closing.  
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services SO close needs.   
 
Report Type 
ECC 
 
FMMI Role 
Accounts Receivable, AR Evaluator Role 
 
Instructions  
STEP 1: Go to Accounts  Receivable > AR Evaluation > Manage  AR Documents > Display Account Balance 
for AR   Items  
 

 
 

 
 
 
STEP 2: To review the customer account, enter the following data: 
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d. Customer account = i.e. 3365613 
e. Status = All Items 
f. Type = check all boxes 
g. Layout = /WS UNCLEARD 
h. Click Execute 

 

 
 

STEP 3: The following screen will appear which lists all the bills and collections applied to this particular 
customer account.  Note the following items: 

a. Green Dots = the bill has been paid in full by the payments applied to it = the bill is fully cleared 
b. Red Dots = the bill has not been paid in full by the payments applied to it = the bill is not fully 

cleared 
 

 
STEP 4: In regards to closing a SO, you need to ensure all items affecting the SO are completely cleared.  In the 
example above that is simply showing a collection not yet applied to a bill.  No action is necessary in this example 
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as the account is not ready to be closed and it will clear on its own once the next RRB bill is produced and FIFO is 
run.   

 
STEP 5: If this were a real example of an account you were trying to close and there were true uncleared items (aka 
system errors), you would need to do the following steps: 

a. Determine which items need to be manually cleared to close the SO.  These must be: 
i. Only the items related to the SO you are trying to close.   

ii. Balanced to zero dollars.   
b. Send an email to Katrina Sopcyk  asking for a F-32 manually clearing.  Example below.   
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FMMI Posting Keys (PK) 
 

Posting keys are two-digit numerical keys that control the entry of line items.  Posting keys are differentiated by customer, 
vendor and G/L accounts.  

SAP delivers predefined posting keys with the standard system. Additional posting keys were created for FMMI.   

FMMI Posting Keys  
(bold = common APHIS AR PKs) 

Posting Key Description 

00 Act assignment model 

01 Customer invoice 

02 Reverse Credit Memo 

03 Expenses 

04 Other receivables 

05 Outgoing payment 

06 Payment difference 

07 Other clearing 

08 Payment clearing 

09 Special G/L debit 

11 Customer credit memo 

12 Reverse invoice 

13 Reverse charges 

14 Other payables 
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15 Incoming payment 

16 Payment difference 

17 Other clearing 

18 Payment clearing 

19 Special G/L credit 

21 Vendor credit memo 

22 Reverse invoice 

25 Vendor payment 

31 Vendor invoice 

32 Reverse credit memo 

34 Other payables 

35 Incoming payment 

36 Payment differences 

37 Other clearing 

38 Payment clearing 

39 Special G/L credit 

40 G/L account debit posting 

50 G/L account credit posting 
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70 Debit asset 

75 Credit entry 

80 Stock initial entry 

81 Costs 

83 Price difference 

84 Consumption 

85 Change in stock 

86 GR/IR debit 

89 Stock inward movement 

90 Stock initial entry 

91 Costs 

93 Price difference 

94 Consumption 

95 Change in stock 

96 GR/IR credit 

99 Stock outward 

0A CH bill doc debit 

0B CH cancel credit memo debit 
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0C CH clearing debit 

0X CH clearing credit 

0Y CH credit memo credit 

0Z CH cancel bill doc debit 

1A CH cancel bill doc debit 

1B CH credit memo debit 

1C CH credit memo debit 

1X CH clearing credit 

1Y CH cancel credit memo credit 

1Z CH bill doc credit 
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FMMI Tips and Tricks 
 

General  (applies throughout FMMI) 
 

FMMI Screen Layout 
 

Header Area - Does not change when the user navigates from one page to another. Includes Top-
level Navigation 
 
Top Level Navigation Ribbon and Tabs - Displays the entry point for navigation using the content 
which is assigned to the user 
 

• First-level tabs display the process areas e.g., Accounts Receivable 
• Second-level tabs display the FMMI roles e.g., Sales Order Processor 
• The menu is different depending on users role(s) 
• A role matches the user’s specific tasks and information needs and is linked to FMMI login 

 
Content Area - Includes: Title Bar, Application Toolbar, Screen Body, and Status Bar. However, content 
available, selections, and icons differ depending on the selected transaction 
 
Navigation Panel Displays - The Navigation Panel is located on the left side of the screen and is divided 
into the following areas: Detailed Navigation and Portal Favorites 
 
Help Button - Access to Job Aids (some may be for other agencies) 
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Back Button 
 
Back button - Do not use the browser or ribbon Back button.  Use the Back button within each report or task, if 
available 
 

 
 
 

Required Fields 
 
In the variable entry screens, only the fields with an * by them are required fields to run the report.  The more fields 
you complete, the quicker you will obtain results and the more limited the data returned will be.   
 
 

Wildcard 
 
The asterisk (*) can be used in any FMMI report or task as a wildcard.  It can be used before, after, or in the middle 
of items.  For example: 

• AP.*.0121 
• AP.*.*36 
• AP.RA.OVHD.* 
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myPortal Favorites – Add Report or Task 
 
You can save your FMMI Favorites as shortcuts on the left margin in FMMI. 

• Using the Top Level Navigation ribbon, navigate to the FMMI task you want to save.   
• On the right, Click on the PAPER ICON. 
• This will show a list of options.  Select ADD TO PORTAL FAVORITES. 
• Note that your report or task is now listed on the left side of the screen under MYPORTAL FAVORITES. 

Now you can avoid the ribbon navigation and just click on your frequently used tasks.  
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myPortal Favorites – Organizing Entries 
 
You can organize your reports and tasks under myPortal Favorites, options include: 

• Renaming  
• Deleting  
• Creating folders 
• Moving 
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Dynamic Selections 
 
Dynamic selections are a way to enhance report selection criteria prior to running the report with variables not 
contained on the variable entries screen.   
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Save Variant 
 
Saving variants allow users to run their typical reports without having to re-enter all of the variables each time.  
Simply enter the variables you wish to use and click on Save As.  Users can make changes to the variables and/or 
resave the variant before  running the report.   
 
Variants saved with a “/” before the name are public variants (i.e. /WS xxxx).  Variants without a “/” before the 
name are private variants (i.e. WS xxxx). 
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Open/Select Variant 
 
Opening/selecting a variant allow users to run their typical reports without having to re-enter all of the variables 
each time.  Simply select the variant you wish to use.  This will populate the variable entry screen with pre-defined 
variables.  Users can make changes to the variables and/or resave the variant before  running the report.   
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Determining the Level of Customization of a Report 
 
Users can determine the level of customization of a FMMI report or task, to a decent degree, by reviewing the 
Transaction Code associated with the report or task.  Simply view the Transaction Code associated with the report 
or task and google it (i.e. google “SAP CJI3”).  Standard SAP functionality runs off of these Transaction Codes and 
if your search provides a conclusive SAP answer (i.e. SAP CJI3 = Project Actual Cost Line Items), it is a standard 
report or task.   
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ECC Reporting  (applies to ECC Reports) 
 

Multiple Selections 
 
Multiple selections allow users to include or exclude specific multiple selections.   
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General  
 
ECC reports are highly customizable to limit or expand the data you wish to see, options include: 

• All of the General Tips and Tricks above, plus… 
• Drill down capabilities (double click on document number to open document, often underlined) 

o Display Document Header 
• Select Layout  
• Change Layout 

o Displayed Columns 
o Sort 
o Subtotals 
o Filter 

• Save Layout 
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BI Reporting  (applies to BI Reports) 
 

Save Layout 
 
Saving layouts allow users to run their typical reports without having to reconfigure the final format of the report 
each time.  Simply create/modify the format you would like your report to display as and click on Save As.  Users 
can make changes to the layouts and/or resave the layouts after running the reports.   
 
Layouts saved with a “/” before the name are public layouts (i.e. /WS xxxx).  Layouts without a “/” before the name 
are private layouts (i.e. WS xxxx). 
 

 

 

Open/Select Layout 
 
Opening/selecting a layout allows users to run their typical reports without having to reconfigure the final format 
each time.  Simply select the layout you wish to use.  This will re-populate the screen with the pre-defined layout.  
Users can make changes to the layouts and/or resave the layouts after running the report.   
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General 
 
BI reports are highly customizable to limit or expand the data you wish to see, options include: 

• All of the General Tips and Tricks above, plus… 
• Drag and Drop 
• Filter 

o Filter  
o Variable Screen (brings you back to the variable entry screen) 

• Settings 
o Conditions (can find specific dollar amount – add > threshold) 
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Subtotals 
 
Users can either bring in subtotals or remove subtotals.  Simply right click on the field you would like to add or 
remove subtotals to or from, click on Properties, Characteristics, and under the General tab change Display Results 
from “always” to “never” or vice versa.  Users must have two or more characteristics in the report for this to work.   
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Researching FMMI User IDs 
 
Purpose 
This guide provides instructions to obtain the User Name associated with a User ID Number in FMMI. 
 
Role 
Funds Management Evaluator 
 
Instructions 
STEP 1: Go to Funds  Management > Evaluation > Display FM Master Data > Display Fund Center 

 

 
 
STEP 2: The following screen will display.  Enter a valid Funds Center (i.e., AP00000000), hit Enter. 
 

 
 
 
 
STEP 3: The following screen will display.  Click in the User Name  Field, then click on the tab next to User 
name  field. 
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STEP 4: The following screen will appear.  Enter the FMMI User ID number (i.e., F0003121) in the User field 
and click on Start Search. 
 

 
 
 
STEP 5: The following screen will display which provides you the User Name  associated with the FMMI User 
Number. 
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For a listing of FMD FMMI User IDs, see Appendix C. 
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Adjustments and Accruals 
 

Adjustment – For non-GL accountants in APHIS, adjustments are primarily used to record the master data 
elements assigned to a particular financial transaction or group of transactions.  The following items are true for 
adjustments: 

• permanent 
• entered with two sides, one debit and one credit  
• there is no effect on cash; each adjustment balances to $0  
• can affect account balances, depending on which master data elements are changed  

 
Accrual – a place holder for a financial transaction or group of transactions which have not yet been posted to the 
financial system for the purpose of financial statement reporting.  The following items are true for accruals: 

• temporary, typically entered at the end of the month and reversed at the beginning of the next month 
• they are only entered with one side, a debit or a credit 
• affects cash like a normal financial transaction    
• do affect the balance of accounts 

 

Two Common Types of Adjustments 
• Expenditure Adjustments:  a process to move expenses from specific master data elements to other 

master data elements, such as BOC or WBS.   
• Collection Adjustments:  a process to move collections from specific master data elements to other master 

data elements.  (aka Transfers, Modifications) 
 

Two Common Types of Accruals 
• Expenditure Accrual:  a process to temporarily alter financial balances to account for a financial 

expenditure transaction or group of expenditure transactions which have not yet been posted to the financial 
system.   

• Revenue Accrual:  a process to temporarily alter financial balances to account for a financial revenue 
transaction or group of revenue transactions which have not yet been posted to the financial system.   
 

Rules for Adjustments 
• Adjustments should be made in the original system (WebTA, GovTrip) whenever possible. 
• Adjustments should only be made for posted transactions in FMMI, the official financial system.   
• Adjustments should include supporting documentation, which may include: 

o A written request from the field  
o Current reports showing error 
o Written explanation of the error, and/or 
o A copy of the original payment request showing the error being corrected 

 

Who can Process Expenditure Adjustments in FMMI   
FMD wrote a policy on this which basically says that: 

• if the error was made by a financial team (mistyping etc.) or they are working on a specific clean-up 
project, the financial team can process the adjustment;  

• if the error was made by the field staff, the adjustment needs to be processed through the program 
headquarters.   
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What should be a Debit or Credit 
• The USSGL Chart of Accounts shows the “normal” balance side of a GL account 

o http://fms.treas.gov/ussgl/index.html  
o ex. GL 6100- operating expenses - has a normal balance of a Debit.  This means that to reverse an 

expense is a Credit, and to post an expense is a Debit. 
 

Expenditure Adjustment Example    

FMMI B2 Example.xls

 
 

 

 

 

 

 

http://fms.treas.gov/ussgl/index.html
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Miscellaneous 

FMMI Dates Explained 
 
Below are the main dates in FMMI. The definition for each was taken from FMMI help. Their names do 
change based on which report or module you are in.  
 
Document Date ‐ The date the document was created.   

• This could be different from the posting date if an AR invoice is created and parked on one date but 
approved at a later date. 

• Date which appears in the document header and can be used for any defined purpose. 
• Can be defined by a person simply by entering any date.   
• For AP this is the Invoice Date.  
• For GL this is called Doc Date. 

 
Posting Date ‐ The date the document posts to the general ledger.   

• The date that determines the posting period and defines in which fiscal period a document posts to the 
General Ledger (regardless of the Document or Entry date). 

• When the document posts to FMMI. In the case of feeders or auto run processes, this run date can be 
defined by a person. Also, if a doc was in park or is super late the Posting Date could be in a future period. 

• Posting date must be in an open period, and that is why it is only seen later than Entry Date. You cannot 
back date posting date to a closed period unless you reopen that period. This should never happen. 

• OH runs based on this date. 
• GL Reports pull based on this date. 

 
Entry/Created Date – The date the accounting document is entered. 

• Entry date is not human defined, it is system defined. You do not see this on the data entry side of 
transactions. 

 
Clearing Date  - The date the item is considered cleared.   

• When clearing, the last posting date of all the documents involved in clearing is set as the clearing date.   
• Clearing denotes all activities from the time a commitment is made for a transaction until it is settled. 

 

 

Transparent Financial Descriptions 
 

• Answer who, what, where, when, and why (as needed) 
• Most people would understand what they mean, without having to pull the document 
• Are abbreviated to fit the allowable space, but still make sense.   

o Examples: 
 May 2014 Copier Maint – Boulder, CO 
 Adj- John Doe PP22- 10 Hours 
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Helpful Links/Resources 
 

• APHIS Homepage 
www.aphis.usda.gov 
 

• FMD Website  
APHIS Homepage   Our Focus   Business Services   Financial Management 

o Travel Service Center (portal log-in required) 
Financial Management > Travel Services Center (Employees Only) 

o FOST 
Financial Management > Financial Operations Services Team 

o Agreement Services Center FAQs 
Financial Management > Financial Services Branch > Agreements Services Center > Frequently Asked 
Questions 
 

• Financial Management Modernization Initiative (FMMI) 
APHIS Homepage > Our Focus > Business Services > Application Systems > Financial Management Modernization 
Initiative (FMMI) 
 

• BOC Handbook 
https://cod.nfc.usda.gov/Documents/toc.html 
 

• Federal Account Symbols and Titles (FAST Book) 
http://www.fiscal.treasury.gov/fsreports/ref/fastBook/fastbook_home.htm 

 
• US Standard General Ledger (USSGL) 

http://fms.treas.gov/ussgl/index.html 
 

• GovTrip: 
https://govtrip.com/govtrip/site/index.jsp 
 

• GSA Travel Resources 
http://www.gsa.gov/portal/content/105307 
 

• GSA Forms Library 
http://www.gsa.gov/portal/forms/type/TOP 
 

• OPM Forms Library 
http://www.opm.gov/forms/ 
 

• Inside APHIS:   
http://inside.aphis.usda.gov/ 
 

• USDA Washington Metro Area Telephone Directory 
http://dc-directory.hqnet.usda.gov/dlsnew/phone.aspx 
 

• Internet Search Engines:   
o www.google.com 
o www.yahoo.com 
o www.bing.com 
o www.ask.com 

 
• APHIS Budget and Accounting Manual (BAM) (portal log-in required)  

 http://inside.aphis.usda.gov/mrpbs/publications/accounting_manual/accounting_manual.shtml 
 
 
 
 

http://www.aphis.usda.gov/
http://www.aphis.usda.gov/wps/portal/aphis/ourfocus/business-services?1dmy&urile=wcm%3apath%3a%2Faphis_content_library%2Fsa_our_focus%2Fsa_business_services%2Fsa_mrpbs_divisions%2Fsa_fmd%2Fct_fmd_main
https://my.aphis.usda.gov/wps/myportal/myaphis/employeeresources/financial/!ut/p/a1/rVVNc5swFPwtPfSoQVgSEkfHk6Z26zBT17XNhXkIyVZrPgKqU_LrCyTTOk0NbmNdkIZd9HbfCjmhs3bCDA5mC9bkGezbdehFdCpGI4JH05trzvF44k4WV-KGTD7QBrA5DcAB7-MH5AUff7liDWBxfesvprPpLTuPj0-MMe6tn3rOygmdUGa2sDtnk9ZQ7EwVyTyzKrPR3sQllPVbXEFUlPm2hLTqFmlZxI8znSbtFwppEmfj4pgyl3KEqdSINnMkGMcIBPU8LLDyMe93rC2pr-IJG3Cc0l5-MMBvN3gVP2D_2PGXgIHEdR0byNxzwF9C1QH6UtO7RWPyplHBT5Y5ps7idyxirCkA58ilLkNUK4GE68VIUyo9ykCrBJzZUFIb38zXu7tw3OS1zecP66z_I7BQFHsju_NdRVVdWfUEuVexhXaXUTmfzLdN8WB3yGQ6d9a_XvfKDt65x7KJ61OhPB9xrgWiQgCKNWiU-EIm4LuKxKxf9lNcXil7qFf8uGiBMfiJK9szSxDlmCOBQaFEx54PHI8YkQO9ejyjl-iVsd1D5mnx3aoysiWYzGTbqMzztDrdq1OEfiOmz41wfe2DZkhSrwktpQmKSdNCgr1EcEkIUXzAiOBiRgCkSTcpFextHVWqPBipeiz4EziQAe9Y-lm_8dkZN-MlpLcXTJEul8tUkNo0A3379P7hs05XwgpM2P6QptHcspgVh4ePaoUgFvX9-M1PwoabIg!!/?1dmy&urile=wcm%3apath%3a%2Fmyaphis_content_library%2Fsa_programs%2Fsa_mrpbs%2Fsa_fmd%2Fsa_tsc
http://www.aphis.usda.gov/wps/portal/aphis/ourfocus/business-services?urile=wcm%3Apath%3A/aphis_content_library/sa_our_focus/sa_business_services/sa_contact_us/sa_fmd/ct_fmd_fost
http://www.aphis.usda.gov/wps/portal/aphis/ourfocus/business-services/sa_financial_management/sa_financial_services_branch/sa_agreements_service_center/ct_asc/!ut/p/a1/jZFRT4MwFIV_iz9g66XgNh-BuQ0G00TnsC_kwkppMsrSIib-eguJLyZO-tTb852055QwkhGmsJcCO9kqvAwzW-RetKLUBRqBl1DwIXhzITw6zitY4N0C8dOOOoEFttvHAKLDJnle7mMK-_tp_nDr77xlAgDeikK0Dnbr5UMKEC2m-eGP5cN__njCBVSnYSoIu2JXz6SqWpIZzCupUJUSL3mDCgVvuOp-CYbrXpbc5IW2J_WootB8ZM2PnJd24ppkZZejKcmJsPFRt0odgVutjcCNWmxucWkL-8WnkLDDOUzk55DVV4W7slk1r7jmel63xqb6MGc0HHVZz4ftXLQ9uTbHY_aV-NVLNGMbcfcNjifzfg!!/?1dmy&urile=wcm%3apath%3a%2Faphis_content_library%2Fsa_our_focus%2Fsa_business_services%2Fsa_financial_management%2Fsa_financial_services_branch%2Fsa_agreements_service_center%2Fct_asc_faqs
http://www.aphis.usda.gov/wps/portal/aphis/ourfocus/business-services?urile=wcm%3apath%3a%2FAPHIS_Content_Library%2FSA_Our_Focus%2FSA_Business_Services%2FSA_Applications_Systems%2FSA_FIMMI
https://cod.nfc.usda.gov/Documents/toc.html
http://www.fiscal.treasury.gov/fsreports/ref/fastBook/fastbook_home.htm
http://fms.treas.gov/ussgl/index.html
https://govtrip.com/govtrip/site/index.jsp
http://www.gsa.gov/portal/content/105307
http://www.gsa.gov/portal/forms/type/TOP
http://www.opm.gov/forms/
http://inside.aphis.usda.gov/
http://dc-directory.hqnet.usda.gov/dlsnew/phone.aspx
http://www.google.com/
http://www.yahoo.com/
http://www.bing.com/
http://www.ask.com/
http://inside.aphis.usda.gov/mrpbs/publications/accounting_manual/accounting_manual.shtml
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Conversion Errors 
o Please refer all conversion error questions to your programs HQ office, or regional office. 
o It sounds as if these will need to be addressed on a one account at a time basis.   
o Minneapolis staff are aware of the conversion errors but are unable to assist due to our lack 

of involvement in the conversion process and our roles.   

DP 98 File  
o The only known way around the DP 98 file would be for all of us to follow standard 

business processes and eliminate exceptions.  It is easy to determine exact expenses billed 
in FMMI (LIACR) when there are no exceptions in the OH and billing processes.    

o There is no report in FMMI that shows this exact detailed data, as far as we are aware, and 
this seems reasonable because it is not a normal business need. 

o The DP 98 file is a file created in the background of FMMI is requested monthly and 
modifies to be in a readable/usable format.   

o Link:  DP 98 Files - APHIS FMMI Reports 

Exceptions/customizations 
o Exceptions/customizations should have a cost benefit analysis done to ensure the benefits 

of the exception/customization outweigh the costs.   
o Exceptions/customizations often cost more in the way of confusion and room for error than 

benefit.   
o Currently FMD FOB reconciles the OH and RRB on ROWE SOs manually, as best as 

currently possible due to volume and staffing constraints.  The process is currently manual 
due to the exceptions.  Cleaning up the processes and getting rid of the exceptions would 
allow for an automated reconciliation process to be established.   

o There are good reasons for standard processes in every system.  Consider this example:  
Let’s say you had a general contractor build your house who wasn’t aware of standard 
building processes.  The electrician also was not aware of standard building processes and 
put the electrical wherever.  The walls went up and years went by.  A plumber came in 
years later to fix your shower.  The plumber didn’t know when he knocked down your 
shower wall that the electrical was behind the wall and broke the electrical in the process. 

 
 

 
 

 

http://www.aphis.usda.gov/wps/portal/aphis/ourfocus/business-services?urile=wcm%3apath%3a%2Faphis_content_library%2Fsa_our_focus%2Fsa_business_services%2Fsa_applications_systems%2Fsa_fimmi%2Fct_reporting_information
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Appendix A- FMMI Doc Types 
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Appendix B - Reallocation Process 
 
US Bank Access Online is designed to only allow cardholders one chance to modify the accounting code and/or 
budget object code (BOC).  Once the transaction is reallocated to modify the accounting code and/or budget object 
code (BOC), and included in a GL extract, it is locked from further changes. 
 
Reallocated transactions (ZS documents) will not be fed to the interface systems to post in the Financial 
Management Modernization Initiative (FMMI) when the cardholder fails to properly validate the BOC.   
 
When reallocating, the cardholder must click on the magnifying glass next to the BOC field to search for a valid 
value to validate the code. 
 

 

 
 
Listed below are some examples of reallocated transactions with either missing BOC or contain invalid BOC.  This 
resulted from the cardholder failing to properly validate the BOC. 
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How do you know if a transaction is locked? 
You can check the Allocations or Comments Tab for the transaction status.  If the transaction is locked, a message 
“has been included in a GL Extract” will populate in one of these two tabs. 
 
The GL extract will populate usually the next business day after the transaction is reallocated. 
 

 
 
The pad lock symbol does not truly indicate that the transaction is locked.  It will populate as soon as the 
transaction is approved. 
 

The  symbol will populate as soon as the accounting information is changed. 
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How can the accounting information be changed if the transaction has already been included in GL extract? 
The cardholder needs to report the transaction to the budget analyst to determine if the accounting adjustment can 
be done in FMMI. 
 
Transaction Availability 
If the transaction has not been included in a GL extract, it can be modified to change the accounting code, BOC, 
and item descriptions.   
 
The GL extraction will not occur if the accounting code and/or BOC have not been changed when the cardholder 
initially approved the transaction.  The transaction is then available for modifications up to six billing cycles (180 
days). 
 
How to reallocate a transaction that has already been “Approved”? 
If the transaction is available for modifications, the cardholder needs to follow the steps below to edit the 
transaction. 
 

1. First select the transaction and click on “Pull Back” button.   
2. Once the transaction has been pulled back, click on the Accounting Code link.  The Allocations tab will 

open. 
3. Click on the “Magnifying Glass” next to the Line of Accounting to search for a valid value. 
4. Once the accounting information is updated, click on Save Allocations button to save changes. 
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How to reallocate a transaction that has already been “Final Approved”? 
If the transaction is available for modifications, the Cardholder and Approving Official need to take the following 
steps to edit the transaction.   
 
STEP 1:   Approving Official will: 

a. Log into Access Online, click on Manager Approval History, select the transaction, and click on Pull 
Back button to pull it back from history. 

b. Click on Manager Approval Queue, select the transaction, and click on Reject button to reject it to the 
Cardholder. 

 
STEP 2:  Cardholder will: 

a. Once the transaction has been rejected, the Cardholder will log into Access Online and navigate to the 
Transaction List. 

b. Click on the Accounting Code link next to the transaction in question.  The Allocations Tab will open. 
c. Click on the Magnifying Glass  next to the Line of Accounting to search for a Valid Value.  Select the 

code. 
d. Click on Save Allocations to save changes. 
e. Approve and forward the transaction to your Approving Official for approval. 
f. Notify the AO that the transaction is pending for his or her approval.  Note:  The final approval shall be 

done quickly to avoid receiving a pre-suspension notice, especially before the transaction is dropped from 
the system. 
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Appendix C - FMD FMMI User IDs 
 

F0000078 DENISE BASSELL 
F0000304 LAN-ANH DAO 
F0000337 CATHERINE TIMMS 
F0000443 CANDY ANDERSON 
F0000490 BRENDA GILLUM 
F0000514 TANICA BUTLER 
F0000524 ELIZABETH JOHNSON GROTH 
F0000581 HEATHER TRAINUM 
F0000656 HARVEY KINCAID 
F0000748 LORI KOROCK 
F0000776 DAWN LARSON 
F0000790 JOANNE LENOX 
F0000809 SHELLY LITTLE 
F0000839 LINDA MAIN 
F0000875 ANTONIO MCFADDEN 
F0000882 JAMIE KIRBY 
F0000889 CHRISTINA MERCER 
F0000897 ROSALIE MEYER 
F0000937 CHRISTINE CARAHER 
F0000995 DEBORAH OBRIEN 
F0001002 SHALON OLSON 
F0001004 KIM OLSON 
F0001122 ANGELA GODFREY 
F0001167 MICHELLE SCHMID 
F0001180 KARIMAE FAULKNER 
F0001210 WAYNE SIMON 
F0001277 LORA SWANSON 
F0001315 JENNIFER TIZCARENO 
F0001328 BARRETT TRIMBLE 
F0001330 JULIE TRIPP 
F0001339 BRIAN TULLOCK 
F0001341 CHEMIN BOLDEN 
F0001365 EDISON VIZUETE 
F0001475 DEREK MEZZE 
F0002099 IRENE FERNANDEZ 
F0002106 THOMAS MURPHY 
F0002120 BONNIE KETOLA 
F0002143 ALLISON NAITHRAM 
F0002369 NAOMI YANG 
F0002959 ROBIN DYER 

F0002961 DARLENE STEPHENS  
F0002962 PAULA DAUGARD 
F0002967 CAROL DINGESS 
F0002968 CAROLYN BROWNE 
F0002969 EILEEN BERKE 
F0002970 JOANNE MANN 
F0002971 GRETCHEN STRECKER 
F0002972 GLORIA BENSON 
F0002973 HILDA ADAME 
F0002974 GIANA JOWERS 
F0002976 JENNIFER ELIAS 
F0002977 KANDY NELSON 
F0002978 LESBIA ORANTES-DE-CARDONA 
F0002980 CONNIE BARNES 
F0002981 LATISHA HOLLMAN 
F0002983 HELEN GREGORY 
F0002987 PEGGY GOBLE 
F0002989 CRYSTAL TOUPIN 
F0002990 PIEDAD AMENABAR 
F0002991 MOUSTAPHA SEYE 
F0002995 MICHAEL VINCE 
F0002998 CHRISTINE SMITH 
F0003002 TOU VANG 
F0003003 SHEILA HENSLEY 
F0003005 PATRICIA SMITH 
F0003006 JOHN YOUNG 
F0003008 ARLICHA STEWART 
F0003009 GAYLE WINES 
F0003010 PAMELA MUILENBURG 
F0003012 QING ZOU 
F0003013 DOUGLAS CREWS 
F0003014 SHARON CRONK 
F0003017 DONNA CICHY 
F0003020 AMY COCHRAN 
F0003023 CRAIG BLICHFELDT 
F0003025 NATHAN JOHNSON 
F0003027 MARIA ANDREA DELOSSANTOS 
F0003031 RENATA BADILLA 
F0003032 MEGAN PHOMMAHAXAY 
F0003034 CLAUDIA ROBERTS 
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F0003038 MARGARET MALIZIO 
F0003058 KIMBERLY RUNNINGEN 
F0003065 ARLETHA STEPE 
F0003066 ROBERT FREULER 
F0003068 SADIE STRONG 
F0003073 MARY KIMBALL 
F0003074 MICHAEL BECHTEL 
F0003075 ANGELINA FALCONE 
F0003077 ANTOINETTE MCPHEARSON 
F0003078 PAMELA WILLIAMS 
F0003080 PATRICIA BROWN 
F0003081 PAUL HANTO 
F0003082 PAULA FLATHER 
F0003084 WALTER PECK 
F0003090 LAURA BLICHFELDT 
F0003103 ADJOA ATAAH 
F0003105 ALIDA ROGSTAD 
F0003107 SEPTEMBER FITZGERALD 
F0003108 BARBARA BLACKWELL 
F0003109 BEATRICE SMITH 
F0003112 BHADRA VADALI 
F0003114 BILLIE MITCHELL 
F0003115 BOBBY HARGROVE 
F0003117 CARLA PERRY HARBOUR 
F0003119 SHANNON FENNELL 
F0003121 CAROL ANDERSON 
F0003122 CAROL FISH 
F0003124 CAROL YORK 
F0003125 CATHERINE SAUNDERS 
F0003126 CHARLEANE GADDIE 
F0003127 CHERYL HERSMAN 
F0003128 CHICKEILLA CARTER 
F0003129 CONNIE MURPHY 
F0003130 CONSTANCE TIMM 
F0003132 NORMA SMITH 
F0003133 HELEN ROBINSON 
F0003134 CYNTHIA JORDAN 
F0003135 SHERI WILKERSON 
F0003138 DONNA SHULTZ 
F0003139 JAMES ROLOFF 
F0003141 JUDITH PIEKARSKI 
F0003142 JANE LARSEN 
F0003144 KARLA KEKELA 

F0003147 KEVIN WILLIAMS 
F0003148 KATHLEEN LEGENDRE 
F0003150 DOROTHEA CHURCHWELL 
F0003150 DOROTHEA JACOBS 
F0003151 FERNANDO PIZA 
F0003152 DONNA RALSTON 
F0003153 DICK AUSTIN 
F0003154 DIANA ALMERAZ 
F0003155 KELLY HUSZAR 
F0003156 EVELYN VARGAS-SEE 
F0003158 KAY JONES 
F0003160 DAWN HALVORSON 
F0003162 RUTHIE BURNEY 
F0003163 MARIA IBANEZ 
F0003164 EVA SCHNEIDER 
F0003165 GABRIELA ZAVALA 
F0003166 ILEANA IZQUIERDO 
F0003167 JONI DAVIS 
F0003170 KRISTINA FRANK 
F0003172 LAURIE MCDONALD 
F0003174 ADA-PATRICIA MOLINA-DE-PEZZAROSSI 

F0003175 PATRICIA FELLERS 
F0003176 DANITA THOMPSON 
F0003177 BECKY GOMEZ 
F0003178 DENISE EDGERTON 
F0003179 TERRINA HAIRSTON 
F0003180 KAREN DOWDY 
F0003183 MARLA KIELER 
F0003185 LATOYA JONES 
F0003186 VIRGINIA RODRIGUEZ 
F0003189 LISA LAYNE 
F0003190 DANIEL QUICK 
F0003192 SUSAN MURPHY 
F0003194 ELIZABETH SPAULDING 
F0003196 CHERYL GALIDA 
F0003197 IGOR TSIBULEVSKIY 
F0003198 JOANNE TOMIKEL 
F0003199 RODNEY WALKER 
F0003202 KIM WILLIAMS 
F0003203 MAYME WHALEY 
F0003204 MELONIE TORILLO 
F0003206 MARLENE O NEAL 
F0003207 DANIEL WILLIAMS 
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F0003210 KEMAMO HOOKANO 
F0003212 OLA GAMALELDIN 
F0003213 JANICE ROKOS 
F0003215 AMY MIZE 
F0003216 LINDA WEAVER 
F0003217 IVONNE ROSENBLATT 
F0003219 LEAH LEELAND 
F0003220 VIKTORIA JOHNSON 
F0003221 LAUREN SHEPHERD 
F0003224 LASHAUN NELSON 
F0003228 MARSHALL PLY 
F0003229 JENNIFER RIVAS 
F0003230 CHARLENE MAYO 
F0003231 LATISHA BEVERLY 
F0003232 SAMUEL DENHAM 
F0003234 PAMELA SCHOEN 
F0003236 DAPHNE O'NEAL-SAMUELSSON 
F0003238 BRITTANY KINNEY 
F0003239 EMILY BROWN 
F0003240 MAVIS FERGUS 
F0003241 ANDREA SMALL 
F0003243 JON FRANCOIS 
F0003244 JACQUELINE TRAN 
F0003245 DAISY MARRERO 
F0003246 SAMANTHA ZIEGLER 
F0003247 SHERMAN TYLER 
F0003249 CHRISTINA KLAUS 
F0003250 MARIA RODRIGUEZ 
F0003253 BENIGNO QUICHOCHO 
F0003254 RAKHEE MASSON 
F0003259 TIMIKA SHIELDS 
F0003260 TONI PARIS 
F0003261 VANESSA STAMPLEY 
F0003262 GLENN ELSTUN 
F0003263 MICHAEL WESLEY 
F0003264 CARRIE CROY OWEN 
F0003265 JACQUELINE SALAZAR 
F0003266 MARNIE DAVIDSON 
F0003267 JACQUELINE TVETER 
F0003268 LOIS PERRY 
F0003269 CHRISTINA TAYLOR 
F0003272 COLLETTE ROSE 
F0003273 SHEILA JACKSON 

F0003274 FRED WANG 
F0003275 BILLIE LENEAR 
F0003276 ROBIN DICKERSON 
F0003277 LARA HICOK 
F0003280 CORY OGLESBY 
F0003282 LATONYA JACKSON 
F0003283 CHERYL AMOS 
F0003284 ERIC GORINSON 
F0003285 SANDRA NAVIA 
F0003286 PATRICIA DONOHUE GALVIN 
F0003287 VIKTORIA MALAKIE 
F0003288 FREDERICK MUCCIARDI 
F0003289 BOB LANBERG 
F0003290 EARL THORPE 
F0003291 LISA SPINELLI 
F0003293 BONNIE SIMPSON 
F0003294 LINDA WASHINGTON 
F0003296 ANDRE NELSON 
F0003305 DEBORAH HELSETH 
F0003306 MELVIN COPELAND 
F0003307 DOROTHY SIMMON 
F0003308 CRYSTAL FRYE 
F0003310 SHIRLEY ROPER 
F0003312 STACEY MUSSER 
F0003313 STEPHANIE DROKE 
F0003314 JOHN KIDD 
F0003318 TIARA BYRD 
F0003320 VICKI HAYGOOD 
F0003322 INGE SANOU 
F0003324 ELIZABETH NOLCOX 
F0003326 ERNESTO RODRIQUEZ 
F0003328 MARIA TINKER 
F0003329 MICHELLE CANADY 
F0003331 VIRGINIA GREEN 
F0003332 MELISSA ARNOLD 
F0003336 JANET AMSALU 
F0003337 MARCO BENAVIDEZ 
F0003338 JAMIE SHULTZ 
F0003339 JESSICA SHAMMAMI 
F0003342 SABRINA FERGUSON 
F0003346 CORI MAYHUE 
F0003347 SONJA HORNE 
F0003348 NICHOLAS JOWERS 
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F0003350 CHERYL REED 
F0003354 XOCHITL MEDINA 
F0003355 YVONNE MEDEIROS 
F0003358 LAURA BLANCO 
F0003360 JOY MONDA 
F0003361 DIANNE ARNOLD 
F0003366 JUSTIN GURKSNIS 
F0003367 GINA WATTS 
F0003368 JEAN BUTTICE 
F0003369 MICHAEL CHIODI 
F0003370 LAURA WEEKS 
F0003371 LAUREEN GARRISON 
F0003372 LINDA CHAN 
F0003374 LISA BURLEY 
F0003376 LISA HURST 
F0003377 ELIZABETH NAPUTI 
F0003378 LORRAINE WOLFE 
F0003379 LOURDES KRAMER 
F0003382 MARCUS BROWN 
F0003384 MARIA BILOTTE 
F0003385 MARIANNA BRUNKOW 
F0003386 MARIANNE RODRIGUEZ 
F0003387 MARIETTE AMUNDSON 
F0003388 MARY WIGGETT 
F0003390 PAMALA HANSON 
F0003391 LAEBETZ NILES HOLMES 
F0003392 PATRICIA DURAN 
F0003393 PHILLIP THOMAS 
F0003395 AMANDA BENNETT 
F0003398 AMBER MILLER 
F0003402 REGINA WOLF 
F0003403 RELINDIS JOOSTEN 
F0003405 RICHARD O NEILL 
F0003406 ROBERTA BUSHMAN 
F0003407 BERTHA HINES 
F0003408 VIELKA DYER 
F0003410 SALLY SWEIGART 
F0003411 AMY CHRISTY 
F0003413 BRENDA SCOTT 
F0003414 KERRY HALLER 
F0003415 SHERYL SHAW 
F0003417 ADRIANNE LEFKOWITZ 
F0003418 CYNTHIA MORALES 

F0003419 ROSA RUIZ 
F0003420 MARIE COSTALES 
F0003422 KARI HOFFMAN 
F0003426 GLADYS SOLANO 
F0003427 ALEJANDRO ZUCARO 
F0003428 JOY LOWE 
F0003431 ALLISON BOEHM 
F0003432 PATRICK JOHNSON 
F0003433 STEPHANIE CARR 
F0003434 RICHARD LEWIS 
F0003436 PATSY BACA 
F0003437 MONICA GURROLA 
F0003438 SUMMER BAILEY 
F0003439 CARRI MARKS 
F0003440 DIONNE MURRAY 
F0003441 MELANIE ADAMS 
F0003443 LA VONNE MARSHALL 
F0003445 LINDA SMITH 
F0003446 RHONDA AMEY 
F0003447 HECTOR CABANTOG 
F0003448 JULIE KAISER 
F0003450 JEAN MONTAGUE 
F0003451 ARRIA CHEELEY 
F0003452 ARACELY GALAN 
F0003454 CARLEEN PEREZ 
F0003455 PENNY KESLER 
F0003456 KIMBERLY HILL 
F0003459 DAVID ALEXANDER 
F0003461 MONTGOMERY JENSEN 
F0003462 LISA HOPKINS 
F0003464 PIA HERRING 
F0003465 LLOYD PEYMBROECK 
F0003466 DENISE PRICE 
F0003467 MARLIES MCQUILLEN 
F0003468 ERIC LONGEN 
F0003470 MINH DANG 
F0003472 JULIA BARON 
F0003473 RESA PERRY 
F0003475 DEBORAH LEVITAN 
F0003476 MARGIE NAPIER 
F0003477 MICHELE MCKAY 
F0003478 KATHERINE JOHNSON 
F0003481 GAIL THOMPSON 
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F0003482 ANGEL CESPEDES 
F0003484 SUSAN GAMBLE 
F0003485 SAMUEL GUY 
F0003486 CAROLDINE RABB-NUOMAH 
F0003489 JOY MURRAY 
F0003490 ANTOINE GERMEILLE 
F0003491 VALERIE NWAOJEI 
F0003497 SHANNON ROGERS 
F0003498 AMY PEREZ 
F0003499 PATRICIA LANE 
F0003500 DOREEN LEWIS 
F0003504 LISA LAMBING 
F0003506 JILL HAND 
F0003507 RHONDA GRAHAM 
F0003509 WILLIAM MALAVE 
F0003513 DAPHNE REID 
F0003519 ANGELA ATKINSON 
F0003520 MATTHEW TRAVIS 
F0003521 RALPH O'NEAL 
F0003524 ENRIQUE DIAZ 
F0003526 MARY WATERBURY 
F0003528 EMILY BRAMHALL 
F0003529 MICHELLE BATTLE 
F0003530 ELIZABETH RIVERA-TIRADO 
F0003531 SHIRLEY ICKES 
F0003532 KIMBERLY WILLIAMS 
F0003533 DARYL SEEMAN 
F0003534 KELLI LUNDY 
F0003535 XOCHILT MIRANDA 
F0003537 CHAELINA DUCKERY 
F0003539 ELIZABETH POGGIALI 
F0003540 TRACI JONES 
F0003544 MONIQUE GARCIA 
F0003545 ROBERT WHEELER 
F0003546 MICHELLE RODRIGUEZ 
F0003548 RICHARD HEIMLICH 
F0003550 CHERYL BOONE 
F0003551 MAMIE SMITH 
F0003553 SAMUEL ERDAHL 
F0003554 LEIGH EAGLE 
F0003556 SANDRA WALLACE 
F0003557 SANDRA TORREZ 
F0003558 SARA MATCHIE 

F0003559 SHARON BRAVO 
F0003560 SHERRY PARSONS 
F0003563 ANA NATARENO 
F0003566 STEVEN TANAKA 
F0003568 SUZY KENT 
F0003569 TANIA HEPBURN 
F0003570 TERESA ERDMAN 
F0003571 TERRI LIMKEMAN 
F0003572 THERESA KERBER 
F0003573 TIMOTHY SOLINGER 
F0003574 TWILA SEAMAN 
F0003575 VALERIE PUTMAN 
F0003576 VIVIENNE BENSON 
F0003577 WILLIAM HUGHES 
F0003579 YOKO HONMA 
F0003580 VALORIE MARTIN 
F0003582 XIMENA MIRANDA 
F0003583 SHARON ORTIZ 
F0003584 JOYCE NOLTE 
F0003585 GREGORY WILKES 
F0003588 KIESHA BELL 
F0003592 JOANN BOTTE 
F0003593 TAMMY WAGNER 
F0003595 VICKIE BOVEE 
F0003596 PALOMA BUTRON 
F0003597 JODY SHREVE 
F0003598 DEBRA HALVORSON 
F0003599 LUCY CURRIE 
F0003600 CONNIE OSMUNDSON 
F0003603 CANDICE SUKO STASTNY 
F0003604 CHERRYL TOPE 
F0003605 DEBORAH MOORE 
F0003606 CYNTHIA ROSS 
F0003610 ELLEN WASHBURN 
F0003612 ANA SANCHEZ 
F0003613 JOHN BEAMON 
F0003614 JOSEPH CLOPTON 
F0003615 DEBORAH SMITH 
F0003616 KITTY STARK 
F0003617 ELAINE LOWELL 
F0003618 JUDITH BERGANINI 
F0003619 ANN PETERS 
F0003621 CHERYL TOWELL 
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F0003622 JOAN WITHYCOMBE 
F0003623 JULIA BLAS 
F0003625 CHARIS GUINTO 
F0003626 DAWN SMITH 
F0003627 JAAP VAN DUIJN 
F0003628 DEBRA LISK 
F0003629 CAROL WALL 
F0003630 JODI WILKENING 
F0003631 CHRISTOPHER POTEETE 
F0003632 BARBRA DAVIS 
F0003633 DONNA JOHNSTON 
F0003634 CHERYL BOVEE 
F0003636 KIMBERLY MOTT 
F0003637 JUANITA CRAWFORD 
F0003638 TANYA HAIRSTON 
F0003639 MARGARET FERRISS 
F0003642 DEBRA PEREZ 
F0003643 EMERLINDA HERNANDEZ 
F0003645 KENNETH HORNER 
F0003647 NORMA MORENO 
F0003651 SHARI EWELL 
F0003652 ROSA NAVA 
F0003655 JANICE SIMONS 
F0003656 CHARLES SMITH 
F0003657 KAREN RAY 
F0003658 DAWN WANCZYK 
F0003659 CARLOS MARTINEZ 
F0003660 CORINNE NYGREN 
F0003662 TRACY JOHNSON 
F0003663 MAYDENE CAMPBELL 
F0003664 MARY MAGGI 
F0003666 LENORA MACNEVIN 
F0003667 FONDA TANNER 
F0003670 DEBORAH STALMAN 
F0003672 LORI STEWART 
F0003673 KARLA MARTINEZ GARCIA 
F0003674 ADRIANNE JACKSON 
F0003675 CAROL MURPHY 
F0003676 JUNE WEISBECK 
F0003677 JAMIE CARSRUD 
F0003678 SANDRA MARTINEZ 
F0003680 DIANE HASHIMOTO 
F0003681 FAITH TAYLOR 

F0003683 ALLISON MATTHEWS 
F0003684 SUSANA MAHNCKE 
F0003687 THERESE MINDEMANN 
F0003688 LAWRANCE LAW 
F0003689 TIMOTHY UDING 
F0003690 JESSICA LITTLE 
F0003691 GLORUSTINE TYNES 
F0003694 SHANNON GILLINGHAM 
F0003696 KELLY SMITH 
F0003697 JOANNE NELSON 
F0003733 PIERE MARTIN 
F0003734 MARCELA LOYO 
F0003738 STEPHANIE STEVENS 
F0003739 BERTA ALTIZER 
F0003740 TINA JENKINS 
F0003742 SHARON PHILLIPS 
F0003743 DIANNA HERBERT 
F0003744 NORMA LOPEZ 
F0003745 RUBY LOADER 
F0003747 KATHLEEN MURRAY 
F0003748 DARLENE SCOTT 
F0003800 MARGAUX NENICHKA 
F0003801 MARTHA GARZA 
F0003813 KENNETH BARTH 
F0003814 CHRISTINA WILLIAMS 
F0003815 JESSIE SHEFFERD 
F0003817 KATHLEEN MOODY 
F0003818 SHIN CHRISTENSEN 
F0003819 ROBERT CAYWOOD 
F0003820 CAROL TUSZYNSKI 
F0003821 HOWARD STOLLER 
F0003822 CHERRI GOLDEN 
F0003823 JULIE FIERSTINE 
F0003824 TAMMIE LONG 
F0003827 MAUREEN HARDISTY 
F0003879 SARITA WHEELER DANIELS 
F0003883 JEANINE GORAL 
F0004238 IRA HUNTER 
F0004402 JENNIFER NURNBERGER 
F0004511 BECKY NYE 
F0004512 TRANG DINH 
F0004513 JONEKA GIVENS 
F0004514 KRAIG PETERSON 
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F0004515 DAVID SANTELMAN 
F0004516 SHAWN ADAMEK 
F0004517 SHANNON BONA 
F0004519 MATTHEW SANDERSON 
F0004522 SOEURETTE DUNN 
F0004559 PATRICIA FUCILE 
F0004567 YAJAIRA TORRES 
F0004707 CHARLEEN FRENCHMAN 
F0005069 TAUNYA SAID 
F0005100 GARY HOWARD 
F0005122 KRISTA DUPRE 
F0005129 BONNIE SILVERNALE 
F0005134 GARY LEFEBVRE 
F0005137 KATRINA SOPCYK 
F0005141 NITA HIRYAK 
F0005168 PENNY STRANG 
F0005175 HERBERT SUBER 
F0005237 MELANIE ROUSE 
F0005243 BETH WOOD 
F0005246 MICHELLE BAHR 
F0005252 PRISCILLA ASKREN 
F0005257 LORINDA PURCELL 
F0005258 REBECCA WILLIAMS 
F0005268 SHARON BARTLETT 
F0005275 KRISTI EWING 
F0005300 AZIZA CLARK 
F0005340 WANDA MCNEIL 
F0005341 SANDRA LEHBERGER 
F0005348 ROBERT GREEN 
F0005379 YVONNE BALLARD 
F0005391 ANNE DUNIGAN 
F0006024 CHARLES SINGER 
F0006057 MANDY HIGHT 
F0006151 MELISSA BEAUCHAMP 
F0006210 JAIME REDMOND 
F0006354 DARNELL BURRELL 
F0006363 JOHN BROWN 
F0006391 PATRICIA KITTLE 
F0006397 KIMTA NGUYEN 
F0006399 THI TRAN 
F0006473 JOANNE GARRETT 
F0006475 VIKRAM KUNREDDY 
F0006487 BETTYANN SINGH 

F0008406 TIMOTHY SHEAD 
F0008600 TONY QUAN 
F0008890 PATRICIA DE GRAFF 
F0008918 BEARIAT BEYENE 
F0008922 BRUCE ADAMIC 
F0009064 MICHAEL JOHNSON 
F0009072 ADRIAN VILLALOBOS 
F0009123 ALYSSA PIERCE 
F0009129 TAYRN GUDE 
F0009139 STEPHANIE KOZAR 
F0009171 EDWARD SMITH 
F0018227 SUSAN DE HOND 
F0018251 BONNIE BRADSHAW 
F0018269 BECKY ROBERTS 
F0018296 PETER QUICHOCHO 
F0018302 MELINDA MILLER 
F0019131 ALAIN FREDERIQUE 
F0019148 KRISTIAN DIXON 
F0019177 SUN YOUNG PARK 
F0019271 AMY SLOAN 
F0019285 KATHRYN COLLINS 
F0019364 NANCY BEAVERS 
F0019446 SARAH TIPLER-SMART 
F0019470 DANIEL MARJANEN 
F0019480 KMORNWAN APINUN 
F0019578 TRAVIS HARRISON 
F0019581 BRIAN KURZHAL 
F0019585 PATRICK CUFF 
F0019597 PEGGY HEINES 
F0019622 LEAH WETCH 
F0019623 DEBORAH KATERS 
F0019644 BUCK RICHARDSON 
F0019706 CRYSTAL LAMARR 
F0019772 TIFFANY STOLEE 
F0019778 SHIRLEY DEAVER 
F0019796 SIPORAH JACKSON 
F0019819 DION CUNNINGHAM BIJOU 
F0019821 CHAUNTINA COLEMAN HOGUE 
F0019872 NICOLE REIN 
F0019913 ALISHA THOMAS 
F0019945 MARK HICKS 
F0019989 NICOLE CIANO NUNEZ 
F0020019 AMIE CHURCHILL 
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F0020031 BRENDA CLAYTON 
F0020050 LELANIE KLEINSMIT 
F0020076 MIN ZENG 
F0020113 LEE SPAULDING 
F0020115 EMILY LAW 
F0020151 LEE STANFIELD 
F0020333 MICHAEL JOSEPH 
F0020340 KIMBERLY ALLEN 
F0020367 NOLAN MEYER 
F0020384 CONSTANCE JONES 
F0020421 BRUCE CODER 
F0020441 JUSTIN RHEA 
F0020470 ADELAIDE FEUKAM 
F0020483 ANDREA HAMANN 
F0020526 NAKIA ANDERSON 
F0020616 NICHOLAS STRATCHKO 
F0020636 RANDALL SARVIS 
F0020668 VERONICA KUCHTA 
F0020671 KAREN SIMON 
F0020787 WHITNEY TURNER 
F0020845 GRACE GALBA-BRIGHT 
F0020921 ALEXANDRA WILKERSON 
F0020938 CHALYCE HOWARD 
F0020954 BUDDY RICHARDS 
F0021004 MELANIE RENELL 
F0021009 LINDA CRAIG 
F0021036 DANIELLE BURRELL 
F0021267 VICTORIA ROACH 
F0021357 TERRY NELSON 
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Print Any File to PDF 
 

Open any document you would like to save as a PDF file , for example an email or an internet page.   

 

Go to File , Click on Print, and you will see a screen similar to this 
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Click on the Adobe PDF icon, under Select Printer 
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Click on Print, and you will see a screen similar to this 

 

Choose where you would like to save the file and change the file name, if you like, and click Save.   

A box like this will pop up while it is creating your new file.   

 

Once the PDF is created, it will look similar to this.   
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FMMI Frequently Used Icons 
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SO Cheat Sheet 
 

SO Details    Display SO, Line Items, Doc Flow  
• SO Number or WBS Element 

 
SO Progress   Reimbursable Order Report (/ZWSLAYOUT) 

• Fund, Fund Center, and WBS Element 
 
Billed Expenses Details  Line Items – Actual Costs/Revenue Report (1_USDA_RRB2) 

• WBS Element and Posting Date Range 
 
Billed Expenses Exceptions DP-98 File 
 
Bills    View a Billing Document  or  SO Doc Flow 

• Billing Doc Number  or  SO Number or WBS Element 
 
Collections   Daily Collections Report 

• Funded Program (WBS) or Customer Number 
 
BudgetFull   Budget Availability Control - AVC Tables  

• 9H and Funded Program (WBS) 
 
Budget Less Indirect ExpensesBudget Availability Control - AVC Tables 

• ZR and Funded Program (WBS) 
 
Budget Availability Only SOF PTD (/RMVD 4610YE) 

• Fund and Fund Center 
 
OH Reconciliation  Line Items – Actual Costs/Revenue Report (/WS OH RECON) 

• WBS Element and Posting Date Range 
 
OH Charged   Line Items – Actual Costs/Revenue Report (/WS OH CHRGD) 

• WBS Element and Cost Element 6100980000 and Posting Date Range 
 
OH Split   Line Items – Actual Costs/Revenue Report (/WS OH SPLIT) 

• WBS Elements (up to 4 per 1 account) 
• Cost Element 6100980000 
• Posting Date Range 

 
OH Earned   Line Items – Actual Costs/Revenue Report (/OH SPLIT) 

• WBS Element and Cost Element 6100980000 
 
OH Spent   Line Items – Actual Costs/Revenue Report (/OH SPENT) 

• WBS Element 
 
OH Avail   Line Items – Actual Costs/Revenue Report (/OH AVAIL) 

• WBS Element 
*Use in combination with SOF PTD.  LIACR does not capture commitments or 
obligations.   

 
Customer Acct Details Customer Line Item Display (/UNCLEARED) 

• Customer Number 
• Status = All Items 
• Type = check all boxes 
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